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Chapter 1 

Using Your Software
Using Your Software

Software Information

EPSON Scan

New :Only for SPC productsNew :Unlock to replace the image data.

Printer Driver

New :Unlock to replace the image data.

User’s Guide

New :Unlock to replace the image data.

EPSON EasyPrintModule

EPSON EasyPrintModule works along with your software to provide easy access to your 
print settings.

EPSON Scan is a TWAIN-compliant scanning 
interface that lets you control all aspects of 
scanning. You can use it as a standalone scanning 
program or use it with another TWAIN-compliant 
scanning program. A fully automatic mode and two 
manual modes are available.

The printer driver is the software that allows you to 
adjust printer settings. In the printer settings window, 
you can specify options such as paper type and 
paper size.

The User’s Guide describes your printer’s features 
and provides step-by-step instructions for using 
them. It also tells you how to maintain your printer, 
solve any problems you may encounter, and 
contact customer support, if necessary.
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ICC Profile (Adobe)
Using Your Software 1

An ICC profile is a file containing information on device color space. Using the ICC profiles 
allows you to apply color management. These profiles will be available for EPSON Scan.

Install the ICC profiles, then the following three profiles will be installed:
AdobeRGB1998.icc
AppleRGB.icc
ColorMatchRGB.icc 

These ICC profiles are licensed by Adobe Systems Incorporated.

PIF DESIGNER

New :Unlock to replace the image data.

EPSON Web-To-Page (For Windows Only)

New :Unlock to replace the image data.

ABBYY FineReader Sprint Plus (For DX6000 Series only)

New :Only for SPC productsNew :Unlock to replace the image data.

EPSON Easy Photo Print

New :Unlock to replace the image data.

PIF DESIGNER lets you create and edit P.I.F. (PRINT 
Image Framer) Frames to use with supported Epson 
digital cameras, Epson printers with a memory card 
slot, or EPSON Easy Photo Print software.

EPSON Web-To-Page makes printing Web pages 
easier by resizing them to fit your paper and giving 
you a preview of your printed output. You can select 
it from your Microsoft Internet Explorer toolbar.

ABBYY FineReader Sprint Plus lets you scan a 
document and convert the text into data that you 
can edit with a word processing program. This 
process is called OCR (Optical Character 
Recognition).
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EPSON Easy Photo Print lets you lay out and print 
digital images on various types of paper. The 
step-by-step instructions in the window let you 
Using Your Software 1

PRINT Image Framer (P.I.F. Frames)

New :Unlock to replace the image data.

EPSON Copy Utility

New :Only for SPC productsNew :Unlock to replace the image data.

EPSON Creativity Suite

New :Unlock to replace the image data.

Overview of Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing 
results. Status Monitor and the printer utilities help you check the printer and keep it in top 
operating condition.

preview the printed images and get the effects you 
want without having to make any difficult settings.

P.I.F. (PRINT Image Framer) Frames let you easily 
decorate your photos. P.I.F. Frames can be used 
with supported Epson digital cameras, Epson 
printers with a memory card slot, or EPSON Easy 
Photo Print software.

The EPSON Copy Utility lets you use your all-in-one 
product connected to your computer just like a 
copy machine. You can enlarge and reduce, print in 
color or black and white, restore faded colors, 
remove dust, enhance text, and adjust image 
brightness and contrast when you copy.

The EPSON Creativity Suite is a group of programs 
that lets you scan, save, manage, edit, and print 
your images. Using the main program, EPSON File 
Manager, you can scan and save your images, and 
then display them in an easy-to-use window. From 
there you can print them, attach them to an e-mail 
message, or open them in an image-editing 
program.



2

APP.FM (A4 size) Rev.CR4CJ35P User’s Guide

Accessing the printer driver for Windows
Using Your Software 1

You can access the printer driver from most Windows applications, the Windows Start 
menu, or the taskbar.

To make settings that apply only to the application you are using, access the printer driver 
from that application.

To make settings that apply to all of your Windows applications, access the printer driver 
from the Start menu or the taskbar.

Refer to the following sections to access the printer driver.

From Windows applications

1. Click Print or Print Setup on the File menu.

2. In the window that appears, click Printer, Setup, Options, Preferences, or 
Properties. (Depending on your application, you may need to click one or a 
combination of these buttons.) 

From the Start menu

1. Windows XP x64 and XP:
Click Start, Control Panel, then click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then click Printers and Faxes.) 

Windows Me, 98 SE, and 2000:
Click Start, point to Settings, then click Printers.

2. Windows XP x64, XP, and 2000:
Select the printer, then click Printing Preferences on the File menu.

Windows Me and 98 SE:
Select the printer, then click Properties on the File menu.

From the shortcut icon on the taskbar

Right-click the printer icon on the taskbar, then select Printer Settings.

To add a short cut icon to the Windows taskbar, first access the printer driver from the Start 
menu as described above. Next, click the Maintenance tab, the Speed & Progress 
button, and then the Monitoring Preferences button. In the Monitoring Preferences 
window, select the Select Shortcut Icon check box.
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Accessing the printer driver for Mac OS X
Using Your Software 1

The table below describes how to access the printer driver dialog boxes.

Getting Information Through Online Help

For Windows

New :We unlocked this section for modification request.You can access online help for items in the printer driver from your application or the 
Windows Start menu.
& See "Accessing the printer driver for Windows" on page 12

In the printer driver window, try one of the following procedures.

❏ Right-click the item, then click Help.

❏ Click the  button at the top right of the window, then click the item.

For Mac OS X

New :We unlocked this section for modification request.Click the  Help button when items such as Print Settings or Color Management are 
selected in the Print dialog box.

Overview of EPSON Creativity Suite

New :We unlocked this section for modification request.

Dialog Box How to Access It

Page Setup Click Page Setup on the File menu of your application.

Print Click Print on the File menu of your application.

EPSON Printer 
Utility

You can access this software in the following two ways:

Double-click the EPSON Printer Utility icon in the Applications folder in 
Macintosh HD. Select the printer from the Printer List, then click OK.

Open the Applications folder on your hard drive, then open the 
Utilities folder and double-click the Print Center or Printer Setup Utility 
icon. Select the appropriate printer from the list, then click the 
Configure or Utility button.
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The EPSON Creativity Suite is a group of programs that lets you scan, save, manage, edit, 
and print your images. Using the main program, EPSON File Manager, you can display 
your images in an easy-to-use window.
Using Your Software 1

From EPSON File Manager, you can select multiple images and print them, drag them to 
a document, attach them to an e-mail message, or open them in a photo-editing program.

Note:
When you install the software from the CD that came with your printer, all of the applications are 
automatically installed on your computer.

The following sections describe the applications and how to access them.

EPSON File Manager

New :For Ink Jet PrinterNew :Unlock to replace the image data.

Use EPSON File Manager to:

❏ Retrieve images from a scanner, digital camera, or memory card and send the files 
directly to the application you want to use

❏ View supported images as thumbnails

❏ View the various applications you can use as project icons in the launch area

❏ Search for images on your hard disk

❏ View images as a slide show

❏ Retouch images 
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Starting EPSON File Manager
Using Your Software 1

There are three ways to start EPSON File Manager:

❏ Double-click the EPSON File Manager icon on the desktop.

❏ Drag and drop images or a folder to the EPSON File Manager icon on the desktop.

❏ For Windows:
Click Start, point to All Programs (Windows XP x64 and XP) or Programs (Windows 
Me, 98 SE, and 2000), point to EPSON Creativity Suite, point to File Manager, and 
then click EPSON File Manager.

For Mac OS X:
Double-click the Applications folder in Macintosh HD, then double-click the EPSON 
folder. Next, double-click the Creativity Suite folder, File Manager folder, and finally 
double-click the EPSON File Manager icon.

Click Next when the confirmation message for Instructions is displayed. The instructions 
appear.

If you select Do Not Show Next Time, the confirmation message will not be displayed the 
next time you start EPSON File Manager.

For more information, select User’s Guide from the Help menu in this application.

Printing Photos the Easy Way

New :Unlock to replace the image data.
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EPSON Easy Photo Print lets you lay out and print digital images on various types of 
paper. The step-by-step instructions in the window let you preview the printed images and 
get the effects you want without having to make any difficult settings.
Using Your Software 1

❏ Using the Custom Print function, you can perform one-click printing with the settings 
you select.

❏ Using the Layout and Print function or P.I.F. Frames, you can make calendars or 
greeting cards.

❏ If your photo files have DPOF (Digital Print Order Format) information, DPOF Print 
starts automatically.

Starting EPSON Easy Photo Print

There are two ways to access EPSON Easy Photo Print:

❏ Double-click the EPSON File Manager icon on the desktop, select the images to use, 
then click the Easy Photo Print icon in the upper part of the EPSON File Manager 
window.

❏ For Windows:
Click Start, point to All Programs (Windows XP x64 and XP) or Programs (Windows 
Me, 98 SE, and 2000), point to EPSON Creativity Suite, then click EPSON Easy 
Photo Print.

For Mac OS X:
Double-click the Applications folder in Macintosh HD, then double-click the EPSON 
folder. Next, double-click the Creativity Suite folder, Easy Photo Print folder, and 
finally double-click the EPSON Easy Photo Print for X icon.

For more information, select User’s Guide from the Help menu in this application.

Making Copies/Copying to Fax

New :For SPC (All-in-one product) only
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New :Unlock to replace the image data.
Using Your Software 1

With the EPSON Copy Utility, you can use your all-in-one product as a copy machine.

You can enlarge and reduce, copy in color or black and white, restore faded colors, 
enhance text, and adjust image brightness and contrast.

For Windows users:
Using the Copy to Fax function, you can also fax selected images if you have a fax printer 
driver installed.

Starting EPSON Copy Utility

There are two ways to access the EPSON Copy Utility:

❏ Double-click the EPSON File Manager icon on the desktop, then click the Scan and 
Copy or Copy to Fax icon in the upper part of the EPSON File Manager window.

❏ For Windows:
Click Start, point to All Programs (Windows XP x64 and XP) or Programs (Windows 
Me, 98 SE, and 2000), point to EPSON Creativity Suite, then click EPSON Copy 
Utility.

For Mac OS X:
Double-click the Applications folder in Macintosh HD, then double-click the EPSON 
folder. Next, double-click the Creativity Suite folder, Copy Utility folder, and finally 
double-click the EPSON Copy Utility icon.

For more information, click the Help button to view the EPSON Copy Utility User’s Guide.
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Attaching Images to E-mail
Using Your Software 1

New :Unlock to replace the image data.

EPSON Attach To Email lets you send e-mail with images. It supports various e-mail 
systems and allows you to resize images before attaching them.

Starting EPSON Attach To Email

There are two ways to access EPSON Attach To Email:

❏ Double-click the EPSON File Manager icon on the desktop, then click the Attach to 
e-mail icon in the upper part of the EPSON File Manager window.

❏ For Windows:
Click Start, point to All Programs (Windows XP x64 and XP) or Programs (Windows 
Me, 98 SE, and 2000), point to EPSON Creativity Suite, then point to EPSON Attach 
To Email, and then click EPSON Attach To Email.

For Mac OS X:
Double-click the Applications folder in Macintosh HD, then double-click the EPSON 
folder. Next, double-click the Creativity Suite folder, and then the Attach To Email 
folder. Finally double-click the EPSON Attach To Email icon.
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Creating Photo Frames
Using Your Software 1

New :Unlock to replace the image data.

PIF DESIGNER lets you create original Frames for your photos, or add captions and 
messages to ready-made Frames to give them a personal touch.

Starting PIF DESIGNER

For Windows:
Click Start, point to All Programs (Windows XP x64 and XP) or Programs (Windows Me, 
98 SE, and 2000), point to EPSON PRINT Image Framer, PIF DESIGNER, and then click 
PIF DESIGNER.

For Mac OS X:
Double-click the Applications folder in Macintosh HD, then double-click the EPSON 
PRINT Image Frame folder, the PIF DESIGNER folder, and finally double-click the PIF 
DESIGNER icon.

For more information, select User’s Guide from the Help menu in this application.

Printing Web Pages to Fit to Your Paper Size

New :For the model with this software onlyNew :Unlock to replace the image data.EPSON Web-To-Page lets you make Web pages fit to your paper size when printing. You 
can also see a preview before printing.
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Note:
This software is for Windows only.
Using Your Software 2

Accessing EPSON Web-To-Page

New :Unlock to replace the image data.After you install EPSON Web-To-Page, the menu bar is displayed on the Microsoft Internet 
Explorer Toolbar. If it does not appear, select Toolbars from the View menu of Internet 
Explorer, and then select EPSON Web-To-Page.

EPSON EasyPrintModule

EPSON EasyPrintModule lets you make paper settings in EPSON application software. 
This module is automatically installed on your computer when you install the other 
software.

Note:
The latest version of the module can be downloaded from the EPSON Web site.
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Uninstalling the Printer Software
Using Your Software 2

Uninstalling the printer driver

You may need to uninstall your printer driver if you:

❏ Upgrade your computer’s operating system

❏ Update your printer driver with a newer version

❏ Have a problem with the printer driver.

If you are upgrading your operating system or updating the printer driver version, be sure 
to uninstall the current printer driver before upgrading or installing the new driver. 
Otherwise, the driver update will not work.

For Windows

New :Depends on model

Note:
❏ To uninstall programs in Windows XP x64 and XP, you must log on to a Computer Administrator 

account.

❏ To uninstall programs in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group).

1. Turn off the printer and disconnect its interface cable.

2. Windows XP x64 and XP:
Click Start and select Control Panel.

Windows Me, 98 SE, and 2000:
Click Start, point to Settings, and select Control Panel.

3. Double-click the Add/Remove Programs icon and select EPSON Printer Software 
from the list.

4. Windows XP x64, XP and 2000:
Click Change/Remove.

Windows Me and 98 SE:
Click Add/Remove.

5. Select the icon for your printer and click OK.

6. Click OK to uninstall the printer driver.
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Note:
If your computer is connected using the USB port in Windows Me and 98 SE, you need to uninstall 
the USB component. Select EPSON USB Printer Devices and click Add/Remove. Then click OK 
Using Your Software 2

to restart the computer. (If EPSON USB Printer Devices does not appear in the Add/Remove 
Programs list, double-click EPUSBUN.EXE on the printer software CD-ROM and follow the 
on-screen instructions.)

For Mac OS X

1. Quit all running applications.

2. Insert the EPSON printer software CD-ROM into your Macintosh.

3. Double-click the Printer Driver folder.

4. Double-click the icon for your printer.

Note:
If the Authorization dialog box appears, enter your password or phrase and click OK.

5. Read the software license agreement and click Accept.

6. Select Uninstall from the menu in the upper left and click Uninstall.

7. Follow the on-screen instructions to uninstall the printer driver.

Note:
If the name of your printer remains in the Print Center or Printer Setup Utility, select the name from 
Printer List and click Delete.

Uninstalling the User’s Guide

For Windows

New :We unlocked this section for modification request.

Note:
❏ To uninstall programs in Windows XP x64 and XP, you must log on to a Computer Administrator 

account.

❏ To uninstall programs in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group).

1. Turn off the printer and disconnect its interface cable.

2. Windows XP x64 and XP:
Click Start, then select Control Panel.
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Windows Me, 98 SE, and 2000:
Click Start, point to Settings, and select Control Panel.
Using Your Software 2

3. Double-click the Add or Remove Programs icon.

4. Select (model name) User’s Guide from the list.

5. Windows XP x64, XP, and 2000:
Click Change/Remove.

Windows Me and 98 SE:
Click Add/Remove.

6. Click OK.

For Macintosh

New :We unlocked this section for modification request.Open the folder for your printer, then drag the User’s Guide folder to the Trash. Also drag 
the (model name) User’s Guide icon on your desktop to the Trash.

Uninstalling other Epson applications

New :We unlocked this section for modification request.You can uninstall applications you do not need. Follow the steps below.

For Windows

Note:
❏ To uninstall applications in Windows XP x64 and XP, you must log on to a Computer 

Administrator account. You cannot uninstall applications if you log on as a Limited user.

❏ To uninstall applications in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group).

1. In Windows XP x64 and XP, click Start, then select Control Panel. In Windows Me, 98 
SE, and 2000, click Start, point to Settings, then select Control Panel.

2. Double-click the Add or Remove Programs icon.

3. Choose the software you want to uninstall from the list of programs.

4. Click Change/Remove in Windows XP x64, XP and 2000, or Add/Remove in Windows 
Me and 98 SE.

5. When the confirmation message appears, click Yes.

6. Follow the on-screen instructions.
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For Mac OS X
Using Your Software 2

Note:
❏ To uninstall applications, you must log on to a Computer Administrator account. You cannot 

uninstall applications if you log on as a Limited account user.

❏ Depending on the application, the Installer may be separated from the Uninstaller.

1. Insert the software CD into the CD-ROM drive. The EPSON software CD opens 
automatically.

2. Open the application folder to uninstall, then double-click your language folder if 
necessary.

3. Double-click the Installer or Uninstaller icon. If the Authenticate dialog box appears, 
enter your password or phrase and click OK.
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Chapter 2 

Paper Handling
Paper Handling 2

Using Special Paper 

New :Unlock to replace the image data.You can achieve good results with most types of plain bond paper. However, coated 
papers provide superior printouts because they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet printers, 
and recommends these papers to ensure high-quality results.

"Paper" on page 133

When loading special paper distributed by Epson, read the instruction sheets packed with 
the paper first and keep the following points in mind.

c
Caution:
Cleaning sheets packaged with Epson special paper should not be used with this printer. The 
cleaning function performed by these sheets is not necessary with this type of printer, and the 
sheets could jam.

Note:
❏ Load the paper into the sheet feeder printable side up. The printable side is usually whiter or 

glossier. See the instruction sheets packed with the paper for more information. Some types of 
paper have cut corners to help identify the correct loading direction.

❏ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing 
on curled paper may cause ink to smear on your printout.

Loading capacities for Epson special media

New :Depends on model (See Spec)Refer to the table below for the loading capacities of Epson special paper and other media.

Media Type Loading Capacity

Epson Premium Ink Jet Plain Paper Up to 100 sheets



6

PAPER.FM (A4 size) Rev.CR4CJ35P User’s Guide

Epson Photo Quality Ink Jet Paper

Epson Bright White Ink Jet Paper

Up to 80 sheets
Paper Handling 2

Storing Epson photo paper

Return unused paper to the original package as soon as you finish printing. Epson 
recommends storing your printouts in a resealable plastic bag. Keep them away from high 
temperature, humidity, and direct sunlight.

Loading Paper

New :Depends on modelFollow these steps to load paper:

1. Open the paper support, then slide out the extension, and then open the feeder guard.

2. Lower the output tray, then slide out the extension.

Epson Premium Glossy Photo Paper

Epson Premium Semigloss Photo Paper

Epson Ultra Glossy Photo Paper

Epson Matte Paper-Heavyweight

Epson Glossy Photo Paper

Up to 20 sheets
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3. Slide the edge guide to the left.
Paper Handling 2

4. Fan a stack of paper, then tap it on a flat surface to even the edges.

5. Load the paper with the printable side up, against the right side of the sheet feeder. 
Then slide the left edge guide against the left edge of the paper, but not too tightly.

Note:
❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Always load paper into the sheet feeder short edge first, even when you are printing 
landscape-oriented pictures.
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❏ Make sure the paper stack fits under the c arrow mark inside the left edge guide.

6. Set the feeder guard back.
Paper Handling 2

Loading Envelopes

New :Depends on model (See Spec)Need an Illustration in step 5Follow these steps to load envelopes:

1. Open the paper support, then slide out the extension, and then open the feeder guard.

2. Lower the output tray, then slide out the extension.

3. Slide the left edge guide to the left.
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4. Load envelopes short edge first with the flap facing down and to the left. Then slide the 
left edge guide against the left edge of the envelopes, but not too tightly.
Paper Handling 2

5. Set the paper thickness lever to the ^ position.

6. Set the feeder guard back.

Note:
❏ The thickness of envelopes and their ability to fold vary widely. If the total thickness of the 

stack of envelopes exceeds 10 mm, press down on the envelopes to flatten them before 
loading. If print quality declines when a stack of envelopes is loaded, load one envelope at 
a time.

❏ You can load up to 10 envelopes at a time in the sheet feeder.

❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope flaps before loading.

❏ Flatten the leading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin, as they may curl during printing.

For printing instructions, see the following instructions.
& See "Printing on Envelopes" on page 44

Selecting the Correct Paper Type

The printer automatically adjusts itself for the type of paper you select in your print settings. 
That is why the paper type setting is so important. It tells your printer what kind of paper 
you are using and adjusts the ink coverage accordingly. The table below lists the settings 
you should choose for your paper.

For this paper Select this Paper Type setting
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Plain paper, sheets

Epson Premium Ink Jet Plain Paper

plain papers 
Paper Handling 3

Note:
The availability of special media varies by location. For the latest information on media available in 
your area, contact Epson customer support.
& See "Technical Support Web Site" on page 125

Epson Bright White Ink Jet Paper

Epson Ultra Glossy Photo Paper Epson Ultra Glossy 

Epson Premium Glossy Photo Paper Epson Premium Glossy 

Epson Premium Semigloss Photo Paper Epson Premium Semigloss 

Epson Glossy Photo Paper Epson Glossy

Epson Matte Paper - Heavyweight

Epson Photo Quality Ink Jet Paper

Epson Matte

Envelopes Envelope
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Chapter 3 

Basic Printing
Basic Printing 3

Introduction

This section guides you through the procedures for different kinds of printing.

Printing Photos

Explains how to print photos on various types of paper.
& See "Printing Photos" on page 33

Printing Documents

Explains how to print documents on various types of paper.
& See "Printing Documents" on page 37
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Printing Web Pages
Basic Printing 3

Explains how to print Web pages so that they fit on a sheet of paper without getting cut off 
on the right side.
& See "Printing Web Pages" on page 41

Printing on Envelopes

Explains how to print on envelopes.
& See "Printing on Envelopes" on page 44
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Printing Photos
Basic Printing 3

Preparing the print file

When you print a borderless photo, part of the image will be cropped off because this 
option enlarges the image slightly beyond the paper size.

Printing on cut sheets

You need to adjust the image file to the size of the paper. If your application has margin 
settings, make sure they are set to zero before printing.

Paper compatible with borderless printing

New :Depends on model (See Spec)If you want to print borderless photos, refer to the table below because borderless printing 
is not available for all types of paper.

Note:
❏ Borderless printing takes longer than normal printing.

❏ Print quality may decline in the top and bottom areas of the printout, or the area may be 
smeared when printing on papers other than those listed above. Print a single sheet to check 
the quality before printing large jobs.

Glossy Photo Paper A4, 13 × 18 cm (5 × 7 in.), 10 × 15 cm (4 × 6 in.)

Matte Paper - Heavyweight A4

Ultra Glossy Photo Paper A4, 13 × 18 cm (5 × 7 in.), 10 × 15 cm (4 × 6 in.)

Premium Glossy Photo Paper A4, 13 × 18 cm (5 × 7 in.), 10 × 15 cm (4 × 6 in.)

Premium Semigloss Photo Paper A4, 10 × 15 cm (4 × 6 in.)
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Loading paper

New :We unlocked this section for modification request.
Basic Printing 3

Refer to the section below for details on loading paper.

"Loading Paper" on page 26

When using special Epson paper, refer to the section below.

"Using Special Paper" on page 25

Printing from EPSON Easy Photo Print

Using EPSON Easy Photo Print included on the CD-ROM is the easiest and quickest way 
to create various photos, such as borderless photos or photos with borders or frames. 
EPSON Easy Photo Print also helps you enhance your photos.

Starting EPSON Easy Photo Print for Windows

Click the Start button, point to Programs or All Programs, point to EPSON Creativity 
Suite, then choose EPSON Easy Photo Print.

For more information, select User's Guide from the Help menu in this application.

Starting EPSON Easy Photo Print for Mac OS X

Double-click the Applications folder in Macintosh HD, EPSON folder, then Creativity 
Suite. Double-click the EPSON Easy Photo Print folder, then the EPSON Easy Photo 
Print for X icon.

For more information, select User's Guide from the Help menu in this application.

Printing from other applications

Printer settings for Windows

New :Depends on modelMatch with printer driver UIFollow these steps to adjust your printer settings.

1. Access the printer settings.
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"Accessing the printer driver for Windows" on page 12
Basic Printing 3

2. Click the Main tab, then select one of the following Quality Options: 

❏ Photo for good quality and speed

❏ Best Photo for the best print quality

3. Select the Borderless check box if you want to print borderless photos.

The Borderless Expansion slider becomes available on the Page Layout screen. If 
you want to control the amount of the image that extends beyond the edges of the 
paper, click the Page Layout tab and adjust the slider.

4. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer settings for Mac OS X

New :Depends on modelMatch with printer driver UI
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Follow these steps to adjust your printer settings.

1. Access the Page Setup dialog box.
Basic Printing 3

"Accessing the printer driver for Mac OS X" on page 13

2. Select the printer you are using as the Format for setting.

3. Select the appropriate Paper Size setting.

4. Select the appropriate Orientation settings.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

"Accessing the printer driver for Mac OS X" on page 13

7. Select the printer you are using as the Printer setting. Then make the Copies & Pages 
settings.
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8. Select Print Settings from the pop-up menu.
Basic Printing 3

9. Select the appropriate Media Type, Color, and Mode settings. See online help for 
details of Print Settings.

"Selecting the Correct Paper Type" on page 29

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Note:
You can control the amount of the image that extends beyond the edges of the paper during 
borderless printing. See online help for details.

Printing Documents
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Loading paper
Basic Printing 3

Refer to the section below for details on loading paper.

"Loading Paper" on page 26

When using special Epson paper, refer to the section below.

"Using Special Paper" on page 25

Printer settings for Windows

New :Match with printer driver UI1. Open the file you want to print.

2. Access the printer settings.

"Accessing the printer driver for Windows" on page 12

3. Click the Main tab, then select one of the following Quality Options: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents with higher text quality

❏ Text & Image for higher quality documents with text and images

4. Select the appropriate Type setting.
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"Selecting the Correct Paper Type" on page 29

5. Select the appropriate Size setting. You can also define a custom paper size. For 
Basic Printing 3

details, see the online help.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click OK to close the printer settings window.

8. Print your file.

Printer settings for Mac OS X

New :Depends on model Match with printer driver UI1. Open the file you want to print.

2. Access the Page Setup dialog box.

"Accessing the printer driver for Mac OS X" on page 13

3. Select the printer you are using as the Format for setting.

4. Select the appropriate Paper Size and Orientation settings. You can also define a 
custom paper size. For details, see the online help.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.
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"Accessing the printer driver for Mac OS X" on page 13
Basic Printing 4

7. Select the printer you are using as the Printer setting. Then make the Copies & Pages 
settings.

8. Select Print Settings from the pop-up menu.

9. Select the appropriate Media Type, Color, and Mode settings. See online help for 
details of Print Settings.

"Selecting the Correct Paper Type" on page 29

10.Click Print to start printing.
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Printing Web Pages
Basic Printing 4

Loading paper

Refer to the section below for details on loading paper.

"Loading Paper" on page 26

When using special Epson paper, refer to the section below.

"Using Special Paper" on page 25

Using EPSON Web-To-Page for Windows

New :Match with printer driver UIThe EPSON Web-To-Page software lets you print Web pages so that they fit within the 
width of your selected paper.

1. In Internet Explorer, go to the Web page you want to print.

If you have installed EPSON Web-To-Page, the EPSON Web-To-Page toolbar appears 
on the Internet Explorer window.

2. Click the Print button on the toolbar. The Print window appears.

Note:
If you want to preview the layout of your printout, click the Preview button on the toolbar.
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3. Right-click the printer icon and choose Printing Preferences in Windows XP x64, XP, 
and 2000, or Properties in Windows Me and 98 SE.
Basic Printing 4

4. Click the Main tab, then select one of the following Quality Options: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages with higher text quality

❏ Text & Image for higher quality pages with text and images

5. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

6. Select the appropriate Size setting. You can also define a custom paper size. For 
details, see the online help.

7. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

8. Click OK to close the printer settings window.

9. Print your page.

Using the Printer Driver for Mac OS X

New :Depends on modelMatch with printer driver UI
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Note:
EPSON Web-To-Page is an application available only to Windows users. Macintosh users can print 
Web pages using the printer driver in Mac OS X.
Basic Printing 4

1. Go to the Web page you want to print.

2. Access the Page Setup dialog box.

"Accessing the printer driver for Mac OS X" on page 13

3. Select the printer you are using as the Format for setting.

4. Select the appropriate Paper Size and Orientation settings. You can also define a 
custom paper size. For details, see the online help.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

"Accessing the printer driver for Mac OS X" on page 13

7. Select the printer you are using as the Printer setting. Then make the Copies & Pages 
settings.
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8. Select Print Settings from the pop-up menu.
Basic Printing 4

9. Select the appropriate Media Type, Color, and Mode settings. See online help for 
details of Print Settings.

"Selecting the Correct Paper Type" on page 29

10.Click Print to start printing.

Printing on Envelopes

Loading envelopes

Refer to the section below for loading envelopes.

"Loading Envelopes" on page 28
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Refer to the section below for the printable area.
& See "Printable area" on page 138
Basic Printing 4

Printer settings for Windows

New :Depends on modelMatch with printer driver UI1. Access the printer settings.

"Accessing the printer driver for Windows" on page 12

2. Click the Main tab, then select one of the following Quality Options: 

❏ Text for most envelopes

❏ Text & Image to print images on the envelope

3. Select Envelope as the Type setting.

4. Select the appropriate envelope size from the available Size settings. You can also 
define a custom size. For details, see the online help.

5. Select Landscape as the Orientation setting.

6. Click OK to close the printer settings window.

7. Print your envelope.
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Printer settings for Mac OS X

New :Depends on modelMatch with printer driver UI
Basic Printing 4

1. Access the Page Setup dialog box.

"Accessing the printer driver for Mac OS X" on page 13

2. Select the printer you are using as the Format for setting.

3. Select the appropriate envelope size as the Paper Size setting. You can also define a 
custom envelope size. For details, see the online help.

4. Select Landscape as the Orientation setting.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

"Accessing the printer driver for Mac OS X" on page 13

7. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.
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8. Select Print Settings from the pop-up menu.
Basic Printing 4

9. Select Envelope as the Media Type setting, then select the appropriate Color and 
Mode settings. See online help for details on Print Settings.

10.Click Print to start printing.

Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the printer button

New :Only for model with this featurePress the y Stop/Clear button to cancel a print job in progress.

For Windows XP x64, XP, and 2000

When you start printing, the Progress Meter appears on your computer screen.
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Click the Stop button to cancel printing.
Basic Printing 4

For Windows Me and 98 SE

You can cancel printing using either the Progress Meter or EPSON Spool Manager. See 
the appropriate section below.

Using the Progress Meter

When you start printing, the Progress Meter appears on your computer screen.

Click the Stop button to cancel printing.

Using EPSON Spool Manager

New :Depends on model
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EPSON Spool Manager is similar to Windows Print Manager. If it receives two or more print 
jobs at one time, it holds them in the order that they were received (with printers on a 
network this may be called a print queue).
Basic Printing 4

When a print job reaches the top of the queue, the EPSON Spool Manager sends the job 
to the printer. You can cancel print jobs from the Spool Manager. You can also view status 
information about print jobs, as well as pause and resume or restart printing.

After you send a print job, your printer button will appear in the lower right corner of your 
screen. Click this button to open the EPSON Spool Manager.

To cancel a print job, select the job in the list and click Cancel.

For Mac OS X 10.3 or later

Note:
The screen shots in this section are from Mac OS X 10.3.

Follow the steps below to cancel a print job.

1. Click your printer icon in the Dock. 

2. In the Document Name list, select the document which is printing.
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3. Click the Delete button to cancel the print job.
Basic Printing 5

For Mac OS X 10.2

Follow the steps below to cancel a print job.

1. Click the Print Center icon in the Dock.

2. In the Printer List, double-click your printer.

3. In the Document Name list, select the document which is printing.

4. Click the Delete button to cancel the print job.
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Chapter 4 

Printing with Special Layout Options
Printing with Special Layout Options 5

Introduction 

You can print with a variety of layouts for special projects, such as booklets and posters.

Double-Sided Printing

New :Unlock to replace the image data.Lets you print on both sides of the paper.
& See "Double-Sided Printing" on page 53

Note:
This feature is not available with Mac OS X.

Fit to Page Printing

New :Unlock to replace the image data.Lets you automatically enlarge or reduce the size of your document to fit the paper size 
selected in the printer driver.
& See "Fit to Page Printing" on page 61

Note for Mac OS X users:
This is a standard feature of Mac OS X 10.4. This feature is not available with Mac OS X 10.3 or 
earlier.
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Pages Per Sheet Printing

New :Unlock to replace the image data.
Printing with Special Layout Options 5

Lets you print two or four pages on a single sheet of paper.
& See "Pages Per Sheet Printing" on page 63

Poster Printing

New :Unlock to replace the image data.Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of 
paper, and then make a poster.
& See "Poster Printing" on page 68

Note:
This feature is not available with Mac OS X.

Watermark Printing

New :Unlock to replace the image data.Lets you print text or an image as a watermark on each page of your printout.
& See "Watermark Printing" on page 73

For example, you can put “Confidential” on an important document.
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Note:
This feature is not available with Mac OS X.
Printing with Special Layout Options 5

Double-Sided Printing

New :Match with printer driver UINew :Unlock to replace the image data.Two types of double-sided printing are available: standard and folded booklet.

Standard double-sided printing allows you to print the odd-numbered pages first. Once 
these pages are printed, you can reload them to print the even-numbered pages onto the 
opposite side of the paper.

Folded booklet double-sided printing allows you to make single-fold booklets. The pages 
that will appear on the outside (after the page is folded) are printed first. The pages that will 
appear inside the booklet can then be printed after you reload the paper into the printer as 
shown in the illustration below.

Single-fold booklet

✽: Binding edge
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You can create a booklet by printing pages 1 and 4 on the first sheet of paper, pages 5 and 
8 on the second sheet, and pages 9 and 12 on the third sheet.
Printing with Special Layout Options 5

After you reload these sheets into the sheet feeder, you can then print pages 2 and 3 on 
the back of the first sheet of paper, pages 6 and 7 on the back of the second sheet, and 
pages 10 and 11 on the back of the third sheet.

The resulting pages can then be folded and bound together into a booklet.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available with borderless printing.

❏ This feature is not available when the printer is accessed over a network or is used as a shared 
printer.

❏ Depending on the paper, stacks of up to 30 sheets can be loaded into the sheet feeder during 
double-sided printing.

❏ Only use papers that are suitable for double-sided printing. Otherwise, the printout quality may 
deteriorate.

❏ Depending on the paper and the amount of ink used to print text and images, ink may bleed 
through to the other side of the paper.

❏ The surface of the paper may be smeared during double-sided printing.

Standard double-sided printing for Windows

New :Depends on modelMatch with printer driver UIFollow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet.

1. Access the printer settings.
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"Accessing the printer driver for Windows" on page 12
Printing with Special Layout Options 5

2. Click the Main tab, then select one of the following Quality Options: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages 

❏ Text & Image for higher quality pages with text and images

❏ Photo for good quality and speed

❏ Best Photo for the best print quality

3. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

4. Select the appropriate Size setting.

5. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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6. Click the Page Layout tab, then select the Double-Sided Printing check box.
Printing with Special Layout Options 5

7. Click Margins to open the Margins window.

8. Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

9. Choose cm or inch as the Unit setting. Then specify the width of the binding margin. 
You can enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches.

Note:
The actual binding margin may be different from the specified settings depending on your 
application. Experiment with a few sheets to examine actual results before printing the entire 
job.

10.Click OK to return to the Page Layout screen. Then click OK to save your settings.
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11.Load paper into the sheet feeder, then send the print job from your application. 
Instructions for generating the even-numbered pages will be displayed while the 
odd-numbered pages are printed.
Printing with Special Layout Options 5

"Loading Paper" on page 26

12.Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. Should this occur, slightly 

curl the sheets in the opposite direction before reloading them.

❏ Align the sheet stack by tapping its edges against a hard, flat surface before reloading the 
stack.

❏ Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or 
the binding margins may be incorrect.

❏ If a paper jam occurs, refer to the following.
& See "The paper jams" on page 119

13.Once the paper is reloaded, click Resume to print the even-numbered pages.

Folded booklet double-sided printing for Windows

New :Depends on modelMatch with printer driver UIUse the following steps to create a folded booklet.

1. Access the printer settings.
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"Accessing the printer driver for Windows" on page 12
Printing with Special Layout Options 5

2. Click the Main tab, then select one of the following Quality Options: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages 

❏ Text & Image for higher quality pages with text and images

❏ Photo for good quality and speed

❏ Best Photo for the best print quality

3. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

4. Select the appropriate Size setting.

5. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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6. Click the Page Layout tab and select the Double-Sided Printing check box. Then 
click the Folded Booklet check box.
Printing with Special Layout Options 5

7. Click Margins to open the Margins window.

8. Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

Note:
When you select Portrait as the Orientation setting, the Left or Right binding positions are 
available. The Top binding position is available when you select Landscape as the Orientation 
setting.

9. Choose cm or inch as the Unit setting. Specify the width of the binding margin.
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Printing with Special Layout Options 6

* : Folding edge

** : Margin

You can enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches. The 
specified margin width will be used on both sides of the fold. For example, if you specify 
a 1 cm margin, you will get a 2 cm margin (a margin of 1 cm will be placed on each side 
of the fold).

10.Click OK to return to the Page Layout screen. Then click OK to save your settings.

11.Load paper into the sheet feeder, then send the print job from your application. 
Instructions for printing the inside pages will be displayed while the outside pages are 
printed.

"Loading Paper" on page 26

12.Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. Should this occur, slightly 

curl the sheets in the opposite direction before reloading them.

❏ Align the sheet stack by tapping its edges against a hard, flat surface before reloading it in 
the printer.

❏ Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or 
the binding margins may be incorrect.

❏ If a paper jam occurs, refer to the following.
& See "The paper jams" on page 119

13.Once the paper is reloaded, click Resume to print the inside pages.

14.Once printing is complete, fold the sheets and bind them together using a stapler or 
other binding method.

Portrait Landscape
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Fit to Page Printing
Printing with Special Layout Options 6

New :Match with printer driver UINew :Unlock to replace the image data.You can use the Fit to Page printing function when you want to print, for example, an A4 
size document on another size paper.

Fit to Page printing automatically resizes your page to the paper size you select. You can 
also resize your page manually.

Note:
This feature is not available with borderless printing.

Note for Mac OS X users:
This is a standard feature of Mac OS X 10.4. To use this feature, make sure to select a standard 
paper size (for example, A4) as the Paper Size setting and the Scale to fit paper size setting. Do 
not select a paper size with a page setup option (for example, Sheet Feeder - Borderless). This 
feature is not available with Mac OS X 10.3 or earlier.

Printer settings for Windows

New :Depends on modelMatch with printer driver UI1. Access the printer settings.
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"Accessing the printer driver for Windows" on page 12
Printing with Special Layout Options 6

2. Click the Main tab, then select one of the following Quality Options: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages 

❏ Text & Image for higher quality pages with text and images

❏ Photo for good quality and speed

❏ Best Photo for the best print quality

3. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

4. Select the appropriate Size setting.

5. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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6. Click the Page Layout tab, then select the Reduce/Enlarge Document check box.
Printing with Special Layout Options 6

7. Do one of the following:

❏ If you selected By Output Paper Size, select the size of the paper you are using 
from the drop-down list.

❏ If you selected By Percentage, use the arrows to choose a percentage.

8. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Pages Per Sheet Printing

New :Match with printer driver UIPages Per Sheet printing allows you to print two or four pages on single sheets of paper.
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Note:
This feature is not available for borderless printing.
Printing with Special Layout Options 6

Printer settings for Windows

New :Depends on modelMatch with printer driver UI1. Access the printer settings.

"Accessing the printer driver for Windows" on page 12

2. Click the Main tab, then select one of the following Quality Option settings: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages 

❏ Text & Image for higher quality pages with text and images

❏ Photo for good quality and speed

❏ Best Photo for the best print quality

3. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

4. Select the appropriate Size setting.

5. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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6. Click the Page Layout tab, select Multi-page, then select Pages Per Sheet.
Printing with Special Layout Options 6

7. Select from the following settings for Pages Per Sheet printing:

8. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer settings for Mac OS X

New :Depends on modelMatch with printer driver UI1. Access the Page Setup dialog box.

2, 4 Prints two or four pages of your document on a single piece of 
paper.

Print Page 
Borders

Prints frames around the pages printed on each sheet.

Page Order Allows you to specify the order in which the pages will be printed 
on the sheet of paper. Some settings may be unavailable, 
depending on the Orientation setting on the Main screen.
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"Accessing the printer driver for Mac OS X" on page 13
Printing with Special Layout Options 6

2. Select the printer you are using as the Format for setting.

3. Select the appropriate Paper Size and Orientation settings.

4. Click OK to close the Page Setup dialog box.

5. Access the Print dialog box.

"Accessing the printer driver for Mac OS X" on page 13

6. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.
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7. Select Layout from the pop-up menu.
Printing with Special Layout Options 6

8. Select from the following settings:

9. Select Print Settings from the pop-up menu.

10.Select the appropriate Media Type, Color, and Mode settings. See the online help for 
details of Print Settings.

Pages per Sheet Prints multiple pages of your document on a single piece of 
paper. You can choose from 1, 2, 4, 6, 9, or 16.

Layout Direction Allows you to specify the order in which the pages will be 
printed on the sheet of paper.

Border Prints a border around the pages printed on each sheet. 
You can choose from None, Single hairline, Single thin line, 
Double hairline, or Double thin line.
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"Selecting the Correct Paper Type" on page 29

After completing the steps above, print one test copy and examine the results before 
Printing with Special Layout Options 6

printing an entire job.

Poster Printing

New :Match with printer driver UIPoster printing allows you to print poster-size images by enlarging one page to cover 
several sheets of paper.

Note:
This feature is not available with Mac OS X.

Printer settings for Windows

New :Depends on model Match with printer driver UI1. Access the printer settings.
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"Accessing the printer driver for Windows" on page 12
Printing with Special Layout Options 6

2. Click the Main tab, then select one of the following Quality Options: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents

❏ Text & Image for higher quality pages with text and images

❏ Photo for good quality and speed

❏ Best Photo for the best print quality

3. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

4. Select the appropriate Size setting.

5. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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6. Click the Page Layout tab and select Multi-Page, then select Poster Printing. Click 
the up or down arrow to select 2x1, 2x2, 3x3, or 4x4.
Printing with Special Layout Options 7

7. Make the Borderless setting according to the following table.

Note:
The Borderless setting for poster printing is not available with Windows Me and 98 SE.

If you select the Borderless check box, the Borderless Expansion slider becomes 
available. If you want to control the amount of the image that extends beyond the edges 
of the paper, click the Page Layout tab and adjust the slider.

Selected Allows you to make posters without cutting the margins and 
overlapping the panels.

Not selected Prints panels with margins to be cut and overlapped.
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8. Click Settings to adjust the way your poster will be printed. The Poster Settings window 
opens.
Printing with Special Layout Options 7

9. Make the following settings:

Note:
❏ If you select the Borderless check box in step 7, the message "The poster prints will be 

borderless." appears on the screen and the settings in the table above are not available.

❏ If you want to print only a few of the panels without printing the entire poster, click the panels 
that you do not want to print.

10.Click OK to close the Poster Settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job. Then follow the instructions.
& "How to make a poster from your printouts" on page 71

How to make a poster from your printouts

New :Match with printer driver UINew :Unlock to replace the image data.

Print Cutting Guides Prints guide lines for cutting.

Overlapping 
Alignment Marks

Slightly overlaps the panels and prints alignment markers 
so that the panels can be aligned more precisely.

Trim Lines Prints border lines on the panels to guide you when 
trimming the pages.
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Here is an example of how to make a poster with 2x2 selected under Poster Printing and 
Overlapping Alignment Marks selected as the print cutting guide.
Printing with Special Layout Options 7

1. Cut off the margin of Sheet 1 along a vertical line through the center of the top and 
bottom cross marks: 

2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily 
tape the two sheets together from the back:

3. Cut the taped sheets in two along a vertical line through the alignment markers (this 
time, a line to the left of the cross marks):
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4. Align the edges of the paper using the alignment markers and tape them together from 
the back:
Printing with Special Layout Options 7

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 together.

6. Repeat the instructions from step 1 to step 4 to tape the top and bottom edges of the 
paper:

7. Cut off the remaining margins.

Watermark Printing

New :Match with printer driver UIWatermark printing allows you to print a text-based or image-based watermark on your 
document.

Note:
❏ This feature is not available with Mac OS X.
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❏ This feature is not available with borderless printing.
Printing with Special Layout Options 7

Printing the watermark for Windows

New :Depends on modelMatch with printer driver UI1. Access the printer settings.

"Accessing the printer driver for Windows" on page 12

2. Click the Main tab, then select one of the following Quality Options: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents with higher text quality

❏ Text & Image for higher quality documents with text and images

3. Select the appropriate Type setting.

"Selecting the Correct Paper Type" on page 29

4. Select the appropriate Size setting.

5. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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6. Click the Page Layout tab, choose the desired watermark from the Watermark list, then 
click Settings.
Printing with Special Layout Options 7

If you want to create your own watermark, see the following instructions.
& "Creating your own watermark for Windows" on page 76

7. Specify the settings you want for the watermark. You can change the position and size 
of the watermark by dragging the image within the preview window.

8. Click OK to return to the Page Layout screen.

9. Click OK to close the printer settings window.
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After completing the steps above, print one test copy and examine the results before 
printing an entire job.
Printing with Special Layout Options 7

Creating your own watermark for Windows

New :Match with printer driver UIYou can add your own text-based or image-based watermarks to the watermark list.

1. Click Add/Del under Watermark on the Page Layout screen. The following window 
appears.

2. Do one of the following:

❏ To use an image file as a watermark, select BMP. Click Browse to locate the bitmap 
file you want to use, then click OK. Type a name for your watermark in the Name 
text box, then click Save.

❏ To create a text-based watermark, select Text. Type your text in the Text box. This 
text will also be used as the watermark name. If you want to change the watermark 
name, type a new name in the Name text box, then click Save.

3. Click OK to return to the Page Layout screen.
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4. Click Settings. The following window appears: 
Printing with Special Layout Options 7

5. Make sure that the appropriate watermark is selected in the Watermark list, then select 
Color, Position, Density, Size, Font, Font Style, and Angle settings. (For details, see the 
online help.) Your settings are reflected in the preview window.

6. When you finish making settings, click OK.
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Chapter 5 

Replacing Ink Cartridges
Replacing Ink Cartridges 7

Checking the Ink Cartridge Status

Using the control panel buttons

For information on using the printer's control panel buttons, see the booklet.

For Windows

Note:
Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink cartridges 
are installed, the ink cartridge status will not be displayed.

To check the ink cartridge status, do one of the following:

❏ Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon 
to the taskbar, 
& See "From the shortcut icon on the taskbar" on page 12

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status 
Monitor 3 button.
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A graphic displays the ink cartridge status.
Replacing Ink Cartridges 7

Note:
If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the 
ink cartridge status. Be sure to replace or reinstall any ink cartridge indicated by EPSON Status 
Monitor 3.

❏ The progress meter appears automatically when you start a print job. You can check 
the ink cartridge status from this window.
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For Mac OS X
Replacing Ink Cartridges 8

You can check the ink cartridge status using EPSON StatusMonitor. Follow the steps 
below.

1. Access the EPSON Printer Utility dialog box.

"Accessing the printer driver for Mac OS X" on page 13

2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

Note:
❏ The graphic displays the ink cartridge status when EPSON StatusMonitor was first opened. To 

update the ink cartridge status, click Update.

❏ If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON StatusMonitor will not display an accurate status of the ink 
cartridge. Be sure to replace or reinstall any ink cartridge indicated by the EPSON 
StatusMonitor.

❏ Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink 
cartridges are installed, the ink cartridge status will not be displayed.

Precautions on Ink Cartridge Replacement

2006/01/13 17:52:47We unlocked this section for modification request.Read all of the instructions in this section before replacing the ink cartridges.
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❏ This printer uses ink cartridges equipped with an IC chip that monitors the amount of ink 
used by each cartridge. Cartridges are usable even if they are removed and reinserted. 
However, some ink is consumed each time cartridges are inserted because the printer 
Replacing Ink Cartridges 8

automatically checks their reliability.

❏ If you need to remove an ink cartridge temporarily, be sure to protect the ink supply 
area from dirt and dust. Store the ink cartridge in the same environment as the printer. 
When storing the cartridge, be sure that its label identifying the color of the ink cartridge 
is facing upward. Do not store ink cartridges upside down.

❏ The valve in the ink supply port is designed to contain any excess ink that may be 
released. However, careful handling is recommended. Do not touch the supply port of 
the ink cartridge or its surrounding area.

❏ Ink is consumed during the following operations: print head cleaning, self-cleaning 
cycle performed when the printer is turned on, and ink charging when an ink cartridge 
is installed.

❏ Ink cartridges with low ink status cannot be used when reinserted.

❏ Do not refill the ink cartridges. Other products not manufactured by Epson may cause 
damage that is not covered by Epson’s warranties, and under certain circumstances, 
may cause erratic printer behavior.

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink from or 
handle the cartridges.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the 
ink supply port. If ink gets on your skin, wash the area thoroughly with soap and water. 
If ink gets into your eyes, flush them immediately with water. If discomfort or vision 
problems continue after a thorough flushing, see a doctor immediately.

❏ Epson recommends the use of genuine Epson ink cartridges. The use of non-genuine 
ink may cause damage that is not covered by Epson's warranties, and under certain 
circumstances, may cause erratic printer behavior. Epson cannot guarantee the quality 
or reliability of non-genuine ink. The ink cartridge status is not displayed when 
non-genuine ink is used.

❏ Leave the old cartridge installed in the printer until you have obtained a replacement; 
otherwise, ink remaining in the print head nozzles may dry out.

❏ You cannot continue printing with one ink cartridge expended, even if the other 
cartridges still contain ink. Before printing, replace the expended cartridge.
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Conserving Black Ink When the Cartridge is Low (For 
Windows)
Replacing Ink Cartridges 8

New :Depends on modelScreen capter is need before bullet structureThe window below appears when black ink runs low and there is more color ink than black 
ink. It appears only when plain papers is selected as the paper type, and Text is selected 
as the Quality Option.

The window gives you the option to either continue using black ink normally or conserve 
black ink by using a mixture of color inks to create black.

❏ Click the Yes button to use a mixture of color inks to create black. You will see the same 
window the next time you print a similar job.

❏ Click the No button to continue using the remaining black ink for the job you are 
printing. You will see the same window the next time you print a similar job, and again 
have the option to conserve black ink.

❏ Click Disable this feature to continue using the remaining black ink. You will not see 
the window again until you replace the black cartridge.

Replacing an Expended Ink Cartridge

New :Only for dye ink with check positionOnly for pigment ink with check positionYou can replace an ink cartridge using the printer buttons or using your computer. Refer to 
the appropriate section below for instructions.

Using the printer's control panel buttons

New :Only for model with LCD screenFor information on using the printer’s control panel buttons, see the booklet.

Using your computer

2006/01/13 17:52:47We unlocked this section for modification request.
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You can monitor the ink cartridge status from your computer and view on-screen 
instructions for replacing a low or expended ink cartridge.
Replacing Ink Cartridges 8

When you need to replace an ink cartridge, click How to in the EPSON Status Monitor 
window. Follow the on-screen instructions to replace the cartridge.

For more information on using your computer to replace ink cartridges, see the section 
below.
& See "Using EPSON Status Monitor 3" on page 110 (Windows) 
& See "Using EPSON StatusMonitor" on page 111 (Mac OS X)

Replacing an Ink Cartridge Before It is Expended

New :Only for separated ink with check positionYou may need to replace an ink cartridge before it is expended if it has been installed in 
your printer for more than six months and print quality declines.

To replace an ink cartridge before the H ink low icon is displayed in the upper-left corner of 
the LCD screen, or EPSON Status Monitor notifies you that the cartridge is expended, 
follow the instructions in this section.

You can replace an ink cartridge using the printer buttons or using your computer.

Using the printer’s control panel buttons

For information on using the printer’s control panel buttons, see the booklet.

Using your computer (for Windows)

New :Only for model with this featureMatch with printer driver UIYou can view on-screen instructions for replacing an ink cartridge using the printer 
maintenance utilities.
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If you need to replace an ink cartridge before it is low or expended, click the button on the 
Maintenance tab.
Replacing Ink Cartridges 8

For more information on using the printer utilities, see the online help.
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Chapter 6 

Maintaining Your Printer
Maintaining Your Printer 8

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able 
to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility 
or from the printer by using the buttons.

Note:
If the error messages indicating ink expended or ink low appear on the LCD screen, you cannot 
check the print head. Replace the appropriate ink cartridge first.

Using the Nozzle Check utility for Windows

New :Match with printer driver UIFollow the steps below to use the Nozzle Check utility.

1. Make sure that no warnings or errors are displayed on the LCD screen.

2. Make sure that A4 size paper is loaded in the sheet feeder.

3. Right-click the printer icon on the taskbar, then select Nozzle Check.

If the printer icon does not appear, refer to the following section to add the icon.

"From the shortcut icon on the taskbar" on page 12

4. Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

New :Match with printer driver UIFollow the steps below to use the Nozzle Check utility.

1. Make sure that no warnings or errors are displayed on the LCD screen.

2. Make sure that A4 paper is loaded in the sheet feeder.

3. Access the EPSON Printer Utility dialog box.
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"Accessing the printer driver for Mac OS X" on page 13

4. Click the Nozzle Check button in the Utility dialog box.
Maintaining Your Printer 8

5. Follow the on-screen instructions.

Cleaning the Print Head

New :Depends on modelIf you find that the printout is unexpectedly faint or that dots are missing, you may be able 
to solve these problems by cleaning the print head, which ensures that the nozzles are 
delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the 
printer driver or from the printer by using the buttons.

Note:
❏ Clean the print head only if print quality declines; for example, if the printout is blurry or the color 

is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves 
ink.

❏ If the error messages indicating ink expended or ink low appear on the LCD screen, you cannot 
clean the print head. Replace the appropriate ink cartridge first.

Using the Head Cleaning utility for Windows

New :Match with printer driver UIFollow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that no warnings or errors are displayed on the LCD screen.

2. Make sure the printer is turned on.

3. Make sure that A4 size paper is loaded in the sheet feeder.

4. Right-click the printer icon on the taskbar, then select Head Cleaning. 

If the printer icon does not appear, refer to the following section to add the icon.

"From the shortcut icon on the taskbar" on page 12

5. Follow the on-screen instructions.

The P On light flashes while the printer performs the cleaning cycle.
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c
Caution:
Never turn off the printer while the P On light is flashing. Doing so may damage the printer.
Maintaining Your Printer 8

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the printer 

off and wait overnight. Then run the nozzle check again and repeat the head cleaning if 
necessary.

❏ If the print quality still has not improved, at least one of your ink cartridges may be old or 
damaged and may need to be replaced.
& See "Replacing an Ink Cartridge Before It is Expended" on page 83

❏ If print quality remains a problem after replacing the ink cartridges, contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at least once every month.

Using the Head Cleaning utility for Mac OS X

New :Match with printer driver UIFollow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that no warnings or errors are displayed on the LCD screen.

2. Make sure the printer is turned on.

3. Make sure that A4 size paper is loaded in the sheet feeder.

4. Access the EPSON Printer Utility.

"Accessing the printer driver for Mac OS X" on page 13

5. Click the Head Cleaning button in the Utility dialog box.

6. Follow the on-screen instructions.

The P On light flashes while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P On light is flashing. Doing so may damage the 
printer.

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the 

printer off and wait overnight. Then run the nozzle check again and repeat the head 
cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink cartridges may be old or 
damaged and may need to be replaced.
& See "Replacing an Ink Cartridge Before It is Expended" on page 83
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❏ If print quality remains a problem after replacing the ink cartridges, contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at least once every month.
Maintaining Your Printer 8

Aligning the Print Head

New :Match with printer driver UIIf you notice a misalignment of vertical lines or horizontal banding, you may be able to 
solve this problem by using the Print Head Alignment utility in your printer driver.

Refer to the appropriate section below.

Note:
Do not press the y Stop/Clear button to cancel printing while printing a test pattern with the Print 
Head Alignment utility.

Using the Print Head Alignment utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no warnings or errors are displayed on the LCD screen.

2. Make sure A4 size plain paper is loaded in the sheet feeder.

3. Right-click the printer icon on the taskbar, then select Print Head Alignment.

If the printer icon does not appear, refer to the following section to add the icon.

"From the shortcut icon on the taskbar" on page 12

4. Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no warnings or errors are displayed on the LCD screen.

2. Make sure A4 size plain paper is loaded in the sheet feeder.

3. Access the EPSON Printer Utility dialog box.

"Accessing the printer driver for Mac OS X" on page 13
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4. Click the Print Head Alignment button in the Utility dialog box.

5. Follow the on-screen instructions to align the print head.
Maintaining Your Printer 8
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Chapter 7 

Using a Memory Card in the Printer
Using a Memory Card in the Printer 9

Introduction

You can use the printer’s memory card slots to copy files to a computer connected to the 
printer. You can also use it to copy files on your computer to your memory card.

For instructions on printing from a memory card, see the booklet that came with your 
printer.

Handling Memory Cards

Memory card copying precautions

Keep the following in mind when copying files between your memory card and computer:

❏ Check the documentation that came with your memory card and any adapter you may 
be using for any handling guidelines.

❏ Do not eject your memory card or turn off the printer while the memory card light is 
flashing or you may lose data.

❏ Make sure that your memory card is not write-protected. Many memory cards have a 
write-protect switch.

❏ Do not copy files to a memory card while you are printing from the memory card.

❏ The printer display does not update information about your memory card after you copy 
files to it or delete files from it. To update the information displayed, wait until the 
memory card light stops flashing, then eject and reload the memory card.

❏ When you are using EPSON File Manager to access photos on your memory card, do 
not remove the memory card until after you close File Manager.

Supported memory cards

You can use the following types of memory cards with your printer:
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CompactFlash SD Memory Card

Microdrive SDHC Memory Card
Using a Memory Card in the Printer 9

* Adapter required.

Note:
See the following for the specifications of memory cards that can be used with the printer
& "Memory card slots" on page 140

Inserting a memory card

1. Turn on the printer.

2. Open the memory card slot cover.

3. Make sure no cards are in any of the slots. Then insert your memory card as shown in 
the illustrations below. 

Memory Stick miniSD card*

Memory Stick Duo* miniSDHC card*

Memory Stick PRO microSD card*

Memory Stick PRO Duo* microSDHC card*

MagicGate Memory Stick xD-Picture Card

MagicGate Memory Stick Duo* xD-Picture Card Type M

MultiMediaCard xD-Picture Card Type H
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Slot Type of Card
Using a Memory Card in the Printer 9

Memory Stick
Memory Stick PRO
MagicGate Memory Stick

Memory Stick Duo*
Memory Stick PRO Duo*
MagicGate Memory Stick Duo*

SD Memory Card
SDHC Memory Card
MultiMedia Card

miniSD card*
miniSDHC card*

microSD card*
microSDHC card* 

xD-Picture Card
xD-Picture Card Type M
xD-Picture Card Type H
*Adapter required

Compact Flash

Microdrive
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4. The memory card light flashes and then stays on. Then close the memory card slot 
cover.
Using a Memory Card in the Printer 9

c
Caution:
❏ Load your memory card only as shown above or you may damage your printer, memory 

card, or both. If you insert a card incorrectly, you see an error message on your screen. 
Click Cancel, then remove the memory card and insert it correctly.

❏ Load only one memory card at a time. Eject your memory card before inserting another 
one.

❏ Always close the memory card slot cover to protect your memory card from static 
electricity. If you touch the inserted memory card, it may cause the printer to malfunction.

❏ If a digital camera is connected to the printer, disconnect it before you insert your memory 
card.

❏ Make sure you check which direction the card should be inserted, and if the card needs 
an adapter make sure you attach the adapter before inserting the card. Otherwise, you 
may not be able to remove the card from the product.

Removing the memory card 

c
Caution:
On a Macintosh, always drag the memory card icon on the desktop into the trash to eject the 
card before you turn off the printer or unplug the USB cable. Otherwise, you may lose data 
from the memory card.

1. Make sure the memory card light is not flashing.

2. Pull the memory card out of its slot.

c
Caution:
Do not remove a memory card when the memory card light is flashing or you may lose data 
from the memory card.
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Copying Files Between a Memory Card and Your Computer
Using a Memory Card in the Printer 9

Copying files to your computer

1. Make sure the printer is turned on and a memory card is inserted.

2. Windows XP x64 and XP
Click Start and select My Computer.

Windows Me, 98 SE, and 2000:
Double-click the My Computer icon on your desktop.

3. Double-click the removable disk icon, then select the folder in which your files are 
saved.

Note:
If you have set a volume label, it is displayed as the drive name. If you have not set the volume 
label, “removable disk” is displayed as the drive name on Windows XP x64 and XP.

4. Select the files you want to copy and drag them to a folder on your computer’s hard 
drive.

Saving files to a memory card

Before inserting your memory card, make sure the write protect switch is set to allow 
writing to the memory card.

Note:
After copying a file to a memory card from a Macintosh computer, an older digital camera not be 
able to read the memory card.

1. Make sure the printer is turned on and a memory card is inserted.

2. Windows XP x64 and XP:
Click Start and select My Computer.

Windows Me, 98 SE, and 2000:
Double-click the My Computer icon on your desktop.

3. Double-click the removable disk icon, then select the folder in which you want to save 
your files.

Note:
If you have set a volume label, it is displayed as the drive name. If you have not set the volume 
label, “removable disk” is displayed as the drive name on Windows XP x64 and XP.
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4. Select the folder on your computer’s hard drive that contains the files you want to copy. 
Then select the files and drag them to the folder on your memory card.
Using a Memory Card in the Printer 9

Disconnecting or Turning Off the Printer

When you finish copying files to or from a memory card in the printer, you must carefully 
follow the steps in these sections before you turn off the printer or disconnect it from your 
computer.

Windows XP x64 and XP

1. Double-click the  icon on the task bar.

2. Select USB Mass Storage Device and click Stop.

3. Select USB Mass Storage Device and click OK.

4. Click anywhere in the window.

5. Turn off the printer or disconnect the USB cable.

Windows 2000

1. Make sure that both the memory card light and the On light are not flashing.

2. Turn off your computer.

3. Turn off the printer or disconnect the USB cable.

Note:
If you turn off the printer or disconnect the USB cable before turning off your computer, you see 
the message “Problem Ejecting USB Mass Storage Device.”

Windows Me and 98 SE

1. Double-click the My Computer icon on the desktop.

2. Right-click the Removable Disk icon and click Eject.

3. Turn off the printer or disconnect the USB cable.
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Macintosh
Using a Memory Card in the Printer 9

1. Drag the removable disk icon ( ) on your desktop into the trash.

2. Turn off the printer or disconnect the USB cable.
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Chapter 8 

Setting Up The Printer on a Network
Setting Up The Printer on a Network 9

Network Setup for Windows XP x64, XP, and 2000

These instructions tell you how to set up your printer so other users on the network can 
share it.

First you will set up the printer as a shared printer on the computer directly connected to it. 
Then you will add the printer to each network computer that will access it.

Note:
❏ These instructions are for small networks only. To share the printer on a large network, consult 

your network administrator.

❏ You must log on to a Computer Administrator account to install software on Windows XP x64 
and XP. After you install Windows XP x64 and XP, the user account is set as Computer 
Administrator.

❏ You must log on to Windows 2000 as a user with administrative privileges (belonging to the 
Administrators group) to install software.

❏ The illustrations in the following section are from Windows XP.

Setting up the printer as a shared printer

Follow the steps below on the computer that is connected directly to the printer:

1. Windows XP x64 and XP:
Click Start and select Control Panel, then double-click Printers and Faxes. (If the 
Control Panel is in Category View, click Printers and Other Hardware, then click 
Printers and Faxes.) 

Windows 2000:
Click Start, point to Settings, and click Printers.

2. Right-click the icon for your printer, then click Sharing.

3. Windows XP x64 and XP:
Select Share this printer, then type a Share name.

Windows 2000:
Select Shared as, then type a name for the shared printer.
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Note:
Do not use spaces or hyphens in the share name.
Setting Up The Printer on a Network 9

If you want Windows XP x64, XP, and 2000 to automatically download printer drivers 
for computers that are running different versions of Windows, click Additional Drivers 
and select the environment and the operating systems of the other computers. Click 
OK, then insert the printer software CD into the CD-ROM drive.

4. Click OK or Close (if you installed additional drivers).

Adding the printer to the other network computers

Follow these steps to add the printer to each network computer that will access it.

Note:
Your printer must be set up as a shared printer on the computer to which it is connected before you 
can access it from another computer.
& See "Setting up the printer as a shared printer" on page 97

1. Windows XP x64 and XP:
Click Start and select Control Panel, then double-click Printers and Faxes. (If the 
Control Panel is in Category View, click Printers and Other Hardware, then click 
Printers and Faxes.) 

Windows 2000:
Click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard appears.
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3. Click Next.

4. Windows XP x64 and XP:
Setting Up The Printer on a Network 9

Select A network printer, or a printer attached to another computer, then click 
Next.

Windows 2000:
Select Network printer, then click Next.

5. On the next screen, click Next.

6. Double-click the icon of the computer that is directly connected to the printer. Then click 
the icon for the printer.

7. Click Next and follow the on-screen instructions.
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Note:
❏ Depending on the operating system and the configuration of the computer to which the printer 

is connected, the Add Printer Wizard may prompt you to install the printer driver from the printer 
Setting Up The Printer on a Network 10

software CD-ROM. Click the Have Disk button and follow the on-screen instructions.

❏ To monitor the status of a shared printer, EPSON Status Monitor 3 must be installed on each 
computer. EPSON Status Monitor 3 is automatically installed when you install the printer 
software.

Network Setup for Windows Me and 98 SE

These instructions tell you how to set up your printer so other users on the network can 
share it.

First you will set up the printer as a shared printer on the computer directly connected to it. 
Then you will add the printer to each network computer that will access it.

Note:
These instructions tell you how to use the printer as a shared network printer. To connect the printer 
directly to a network without setting it up as a shared printer, consult your network administrator.

Setting up the printer as a shared printer

Follow the steps below on the computer that is connected directly to the printer:

1. Click Start, point to Settings, and click Control Panel.

2. Double-click the Network icon.

3. Click File and Print Sharing.

4. Select I want to be able to allow others to print to my printer(s) and click OK.

5. In the Network window, click OK.

6. In the Control Panel window, double-click the Printers icon.
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Note:
❏ If a message appears requesting that you insert the Windows Me or 98 SE CD-ROM, insert 

the CD into the CD-ROM drive and follow the on-screen instructions.
Setting Up The Printer on a Network 10

❏ If a message appears requesting that you restart your computer, restart it, then open the 
Printers folder and continue with step 7.

7. Select the icon for your printer in the Printers folder.

8. Open the File menu and click Sharing.

9. Select Shared As, enter the information for your printer, and click OK.

Accessing the printer through a network

Follow these steps to add the printer to each network computer that will access it.

Note:
Your printer must be set up as a shared printer on the computer to which it is connected before you 
can access it from another computer.
& See "Setting up the printer as a shared printer" on page 100

1. Click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard appears.

3. Click Next.
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4. Select Network printer and click Next.
Setting Up The Printer on a Network 10

5. On the next screen, click Browse.

6. Double-click the icon of the computer that is directly connected to the printer. Then click 
the icon for your printer.

7. Click OK and follow the on-screen instructions.

Note:
To monitor the status of a shared printer, EPSON Status Monitor 3 must be installed on each 
computer. EPSON Status Monitor 3 is automatically installed when you install the printer 
software.
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Network Setup for Mac OS X 
Setting Up The Printer on a Network 10

To set up your printer on a Macintosh OS X network, use the Printer Sharing setting that is 
a standard feature of Mac OS X 10.2 or later. See your Macintosh documentation for 
details.
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Chapter 9 

Troubleshooting
Troubleshooting 10

Diagnosing the Problem

Troubleshooting printer problems is best handled in two steps: first diagnose the problem, 
then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided 
by online problem solving, the control panel, the EPSON Status Monitor utility, or by 
running a printer operation check. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printout problem not related to print 
quality, or a paper feeding problem, or if the printer does not print at all, refer to the 
appropriate section.

To solve a problem, you may need to cancel printing.
& See "Canceling Printing" on page 47

Error indicators

New :Depends on model (See Spec)You can identify many common printer problems using the LCD screen on your printer. If 
the printer stops working and one of the following error messages appears on the LCD 
screen, use this table to diagnose the problem, then follow the recommended corrective 
measures.

LCD Screen Cause Solution

Icon 
display

Text display

Ink cartridges are 
running low on ink.

& See "Replacing an Expended 
Ink Cartridge" on page 82

An ink cartridge is 
expended.

Change the expended ink 
cartridges.
& See "Replacing an Expended 
Ink Cartridge" on page 82
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The ink cartridge is not 
installed or not installed 
correctly.

Install the ink cartridges 
correctly.
See the booklet.
Troubleshooting 10

No paper is loaded in 
the sheet feeder. 

Load paper in the sheet feeder. 
Then press x Start to continue or 
y Stop/Clear to cancel.
& See "Loading Paper" on page 
26
& See "Loading Envelopes" on 
page 28

Paper is jammed. Clean the jam, then press x 
Start.
& See "The paper jams" on page 
119

Not enough ink to 
perform head cleaning.

Replace with new ink cartridges.
& See "Replacing an Expended 
Ink Cartridge" on page 82

There is a problem with 
the printer. 

Turn the printer off and then 
back on. If the error does not 
clear, contact your dealer.
& See "Contacting Customer 
Support" on page 125

Waste ink pad in the 
product is saturated.

Contact your dealer to replace 
it.
& See "Contacting Customer 
Support" on page 125

The memory card does 
not contain any valid 
images. 

Remove the memory card.
& See "Handling Memory Cards" 
on page 90

Memory card error. Remove the memory card.
& See "Handling Memory Cards" 
on page 90
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The paper thickness 
lever is set to the wrong 
position. 

Set the paper thickness lever to 
the correct position and try 
again.
Troubleshooting 10

EPSON Status Monitor (For Windows Only)

New :We unlocked this section for modification request.If a problem occurs while printing, an error message will appear in the Progress Meter 
window.

When you need to replace an ink cartridge, click the How To button on the screen, and 
EPSON Status Monitor will lead you step-by-step through the cartridge replacement 
procedure.

If an error message appears indicating the parts inside the printer are near the end of their 
service life, the waste ink pad in the printer is saturated. Contact your dealer to replace it.

Running a printer operation check

New :Depends on modelIf you are unable to determine the source of the problem, run a printer operation check to 
help you determine whether the problem comes from the printer or your computer.

To run a printer operation check, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the interface connector of the printer.

3. Make sure that A4 size paper is loaded in the sheet feeder.

4. Press the P On button to turn on the printer.

5. Press the F [Setup/Utilities] button to enter the setup mode. 

If you are printing on paper, 
move the lever to the m position. 
If you are printing on envelopes, 
move the lever to the ^ 
position.

No memory card is 
inserted. 

Insert a valid memory card and 
try again.
& See "Handling Memory Cards" 
on page 90
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6. Press the l or r button to select the check ink nozzles icon, as shown below. 
Troubleshooting 10

7. Press the x Start button to start the ink nozzle check. 

A test page prints showing a nozzle check pattern. (If the pattern has gaps, you need to 
clean the print head.
& See "Cleaning the Print Head" on page 86)

❏ If the test page prints, the problem probably lies in your software settings, the cable, or 
your computer. It is also possible that your software may not be installed correctly. Try 
uninstalling your software and reinstalling it.
& See "Uninstalling the Printer Software" on page 21

❏ If the test page does not print, you may have a problem with your printer. Try the 
suggestions in the following section.
& See "The Printer Does Not Print" on page 120

If nothing works, contact Epson.
& See "Contacting Customer Support" on page 125
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Checking Printer Status
Troubleshooting 10

For Windows

Using the progress meter

When you send a print job to the printer, the progress meter appears, as shown in the 
illustration below.

The progress meter indicates the progress of the current print job and provides printer 
status information. This window also displays error messages as well as helpful tips for 
better printing. Refer to the appropriate section below.

Tips

Tips for getting the most out of your Epson printer driver appear in the text box of the 
progress meter window. A new tip appears every 30 seconds. For more details on the tip 
displayed in the window, click the Details button.
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Error messages
Troubleshooting 10

If a problem occurs during printing, an error message appears in the text box of the 
progress meter window. For more detailed information, click Technical Support to access 
the online User’s Guide.

When the ink is low or expended, a How to button appears. Click How to, and EPSON 
Status Monitor 3 will lead you step-by-step through the cartridge replacement procedure.

Using EPSON Spool Manager

New :Depends on modelEPSON Spool Manager is similar to the Windows Print Manager. If it receives two or more 
print jobs at one time, it holds them in the order that they were received (with printers on a 
network, this may be called a print queue). When a print job reaches the top of the line, 
EPSON Spool Manager sends the job to the printer.

From the spool manager, you can view print status information about print jobs that have 
been sent to the printer. You can also cancel, pause, and resume selected print jobs.

Note:
EPSON Spool Manager is not available with Windows XP x64, XP or 2000.
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After you send a print job, a printer icon appears on the task bar. Click this icon to open 
EPSON Spool Manager.
Troubleshooting 11

Using EPSON Status Monitor 3

New :Depends on modelEPSON Status Monitor 3 displays detailed information on the printer status.

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the printer shortcut icon on the Windows taskbar.
& See "From the shortcut icon on the taskbar" on page 12 to add short cut icon on the 
Windows taskbar.

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status 
Monitor 3 button.
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When you access EPSON Status Monitor 3, the following window appears:
Troubleshooting 11

EPSON Status Monitor 3 provides the following information:

❏ Current Status:
If the ink is low or expended, the How to button appears in the EPSON Status Monitor 3 
window. Clicking How to displays ink cartridge replacement instructions and moves the 
print head to the ink cartridge replacement position.

❏ Ink Cartridge Status:
EPSON Status Monitor 3 provides a graphic display of the ink cartridge status and an 
estimate of the number of pages that can be printed before the ink cartridge should be 
replaced.

❏ Ink Cartridge Information:
You can view information about the installed ink cartridges by clicking Information.

❏ Technical Support:
You can access the online User’s Guide from EPSON Status Monitor 3. If you 
encounter a problem, click Technical Support in the EPSON Status Monitor 3 window.

For Mac OS X

Using EPSON StatusMonitor

If EPSON StatusMonitor detects a printer problem, it will inform you with an error message.

Follow these steps to access EPSON StatusMonitor.
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1. Access the EPSON Printer Utility.

"Accessing the printer driver for Mac OS X" on page 13
Troubleshooting 11

2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

When ink is low or expended, a How to button appears. Click How to, and EPSON 
StatusMonitor will lead you step by step through the ink cartridge replacement procedure.
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You can also use this utility to check the ink cartridge status before printing. 
EPSON StatusMonitor displays the ink cartridge status at the time it was opened. To 
update the ink cartridge status, click Update.
Troubleshooting 11

Print Quality Problems

New :Unlock to replace the image data.If you are having print quality problems, then compare it with the illustrations below. Click 
the caption under the illustration that best resembles your printout.

Good sample Good sample

"Horizontal banding" on page 114 "Vertical misalignment or banding" on 
page 114

"Horizontal banding" on page 114 "Vertical misalignment or banding" on 
page 114

"Incorrect or missing colors" on page 114 "Blurry or smeared printout" on page 115
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Horizontal banding
Troubleshooting 11

❏ Make sure the printable side of the paper is face up in the sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See "Cleaning the Print Head" on page 86

❏ Use ink cartridges within six months after opening the packages.

❏ Use genuine Epson ink cartridges.

❏ Check the ink cartridge status by using EPSON Status Monitor 3 (Windows) or EPSON 
StatusMonitor (Macintosh).
& See "Checking the Ink Cartridge Status" on page 78
If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
& See "Replacing an Expended Ink Cartridge" on page 82

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See "Selecting the Correct Paper Type" on page 29

Vertical misalignment or banding

❏ Make sure the printable side of the paper is face up in the sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See "Cleaning the Print Head" on page 86

❏ Run the Print Head Alignment utility.
& See "Aligning the Print Head" on page 88

❏ Clear the High Speed check box in your Advanced printer settings. See the online help 
for details.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See "Selecting the Correct Paper Type" on page 29

Incorrect or missing colors

New :Depends on model match with printer driverUI

❏ Clear the Black Ink Only setting in your printer driver (for Windows). Change the Ink 
setting in your printer driver to Color (for Macintosh). See the online help for details.

❏ Adjust the color settings in your application or in your Advanced printer settings. See 
the online help for details.
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❏ Run the Head Cleaning utility.
& See "Cleaning the Print Head" on page 86
Troubleshooting 11

❏ Check the ink cartridge status by using EPSON Status Monitor 3 (Windows) or EPSON 
StatusMonitor (Macintosh).
& See "Checking the Ink Cartridge Status" on page 78
If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
& See "Replacing an Expended Ink Cartridge" on page 82

❏ If you have just replaced an ink cartridge, make sure the date on the box has not 
expired. If you have not used the printer for a long time, replace the ink cartridges.
& See "Replacing an Ink Cartridge Before It is Expended" on page 83

Blurry or smeared printout

New :Match with printer driver UI

❏ Use only paper recommended by Epson.
& See "Paper" on page 133

❏ Use genuine Epson ink cartridges.

❏ Make sure the printer is on a flat, stable surface that extends beyond the base in all 
directions. The printer will not operate properly if it is tilted.

❏ Make sure your paper is not damaged, dirty, or too old.

❏ Make sure your paper is dry and the printable side is facing up.

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite 
direction.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See "Selecting the Correct Paper Type" on page 29

❏ Remove each sheet from the output tray as it is printed.

❏ If you are printing on glossy media, place a support sheet (or a sheet of plain paper) 
beneath the stack, or load only one sheet at a time.

❏ Do not touch or allow anything to come into contact with the printed side of paper with 
a shiny finish. After printing on glossy paper, allow the ink to set for a few hours before 
handling them.

❏ Run the Head Cleaning utility.
& See "Cleaning the Print Head" on page 86
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Miscellaneous Printout Problems
Troubleshooting 11

Incorrect or garbled characters

❏ Clear any stalled print jobs from the Spool Manager (Windows Me and 98 SE).
& See "Canceling Printing" on page 47

❏ Turn off the printer and computer. Make sure the printer’s interface cable is securely 
plugged in.

❏ Uninstall the printer driver, then reinstall it.
& See "Uninstalling the Printer Software" on page 21

Incorrect margins

❏ Check the margin settings in your application. Make sure that the margins are within the 
printable area of the page.
& See "Printable area" on page 138

❏ Check the printer settings on the Main window (Windows) or in the Page Setup dialog 
box (Macintosh). Make sure the settings are appropriate for the paper size you are 
using. See the online help for details.

❏ Uninstall the printer driver, then reinstall it.
& See "Uninstalling the Printer Software" on page 21

Inverted image

New :Match with printer driver UI

❏ Clear the Mirror Image check box in the printer driver, or turn off the “Mirror Image” 
setting in your application. For instructions, see the online help for the printer driver or 
for your application.

❏ Uninstall the printer driver, then reinstall it.
& See "Uninstalling the Printer Software" on page 21

Blank pages print

❏ Check the printer settings on the Main window (Windows) or in the Page Setup dialog 
box (Macintosh). Make sure the settings are appropriate for the paper size you are 
using. See the online help for details.
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❏ Uninstall the printer driver, then reinstall it.
& See "Uninstalling the Printer Software" on page 21
Troubleshooting 11

After trying one or more of these solutions, run a printer operation check to check your 
results.
& See "Running a printer operation check" on page 106

Printed side is smeared or scuffed

New :match with printer driver UI

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite 
direction.

❏ Clear the High Speed check box in your Advanced printer settings. See the online help 
for details.

❏ Make several copies without placing a document on the document table. If the problem 
persists, ink may have leaked inside the printer, so wipe the inside of the printer with a 
soft, clean cloth.

❏ If you are printing on thick paper or envelopes, set the paper thickness lever to the 
^ position.

❏ Uninstall the printer driver, then reinstall it.
& See "Uninstalling the Printer Software" on page 21

Printing is too slow

New :Match with printer driver UINew :We unlocked this section for modification request.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See "Selecting the Correct Paper Type" on page 29

❏ Clear all customized settings and select Text as the Quality Option in your printer 
settings (Windows). Clear all customized settings and select Automatic as the Mode in 
your printer settings (Macintosh), then move the slider to Speed. See the online help for 
more information.
& See "Accessing the printer driver for Windows" on page 12.
& See "Accessing the printer driver for Mac OS X" on page 13

❏ Close any unnecessary applications.



8

TRBLE.FM (A4 size) Rev.CR4CJ35P User’s Guide

❏ If you print continuously for an extended period, the paper may temporarily stop feeding 
or the print head carriage may pause for a while. This is to slow down the printing speed 
and prevent the printer mechanism from overheating and being damaged. If this 
Troubleshooting 11

happens, you can continue to print, but we recommend stopping and leaving the printer 
for about thirty minutes with the power on. (The printer does not recover with the power 
off.) After you restart, the printer will print at normal speed.

❏ Uninstall the printer driver, then reinstall it.
& See "Uninstalling the Printer Software" on page 21

If you try all of the methods above and cannot solve the problem, see the following:
& "Increasing the Print Speed" on page 122

Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with the paper for more 
information.

❏ The paper fits under the c arrow mark inside the left edge guide.

❏ The number of sheets in the paper stack does not exceed the limit specified for the 
media.
& See "Loading capacities for Epson special media" on page 25

❏ Paper is not jammed inside the printer. If it is, remove the jammed paper.
& See "The paper jams" on page 119

❏ The ink cartridges are not expended. If a cartridge is expended, replace it.
& See "Replacing an Expended Ink Cartridge" on page 82

❏ You have followed any special loading instructions that came with your paper. Load the 
paper again.
& See "Loading Paper" on page 26

Multiple pages feed

❏ Make sure the paper stack fits under the c arrow mark inside the left edge guide.
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❏ Make sure the left edge guide is snug against the left edge of the paper.

❏ Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the 
Troubleshooting 11

opposite side before loading.

❏ Remove the stack of paper and make sure that the paper is not too thin.
& See "Paper" on page 137

❏ Fan the edges of the stack to separate the sheets, then reload the paper.

❏ If too many copies of a file are being printed, check the Copies setting on the Page 
Layout window (Windows) or in the Print dialog box (Macintosh) and in your application. 
See the online help for details.

The paper jams

New :Depends on model (See spec)If paper is jammed inside the printer, an error message appears on the LCD screen. Press 
the x Start button to eject the jammed paper. If the error does not clear, turn the printer off 
and open the scanner unit, then remove all of the paper inside, including any torn pieces. 
Then close the scanner unit, turn the printer on, reload the paper, and press the x Start 
button to resume printing.

Note:
If you cannot easily remove a foreign object, do not use force and do not disassemble the printer. 
Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ You are using high quality paper.

❏ The printable side of the paper is face up in the sheet feeder.

❏ The paper stack was fanned before loading.

❏ The paper is not loaded above the c arrow mark on the left edge guide.

❏ The paper stack fits under the tabs inside the edge guides.

❏ The number of sheets in the paper stack does not exceed the limit specified for that 
paper. 
& See "Loading capacities for Epson special media" on page 25

❏ The left edge guide is snug against the left edge of the paper.
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❏ The printer is on a flat, stable surface that extends beyond the base in all directions. 
The printer will not operate properly if it is tilted.
Troubleshooting 12

Paper is improperly loaded

If you have loaded the paper too far into the printer, the printer cannot feed the paper 
correctly. Turn the printer off and gently remove the paper. Then turn the printer on and 
reload the paper correctly.

Paper is not ejected fully or is wrinkled

❏ Clear the jammed paper as explained in "The paper jams" on page 119. Also, check the 
Paper Size setting in your application or printer settings. See online help for details. 

❏ If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack 
of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The Printer Does Not Print

The LCD panel and the lights are off

❏ Press the P On button to make sure the printer is on.

❏ Turn off the printer and make sure that the power cord is securely plugged in.

❏ Make sure that your outlet works and is not controlled by a wall switch or timer.

The LCD panel and the lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the printer and unplug it 
immediately. Then check the label on the back of the printer.

c
Caution:
If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact your 
dealer.
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The LCD panel and the lights are on
Troubleshooting 12

❏ Turn off the printer and computer. Make sure the printer’s interface cable is securely 
plugged in.

❏ If you are using the USB interface, make sure your cable meets the USB 1.1 or 2.0 
standards.

❏ Make sure there is no packing material in the printer.

❏ Turn off the printer and the computer, disconnect the printer’s interface cable, then print 
an operation check page.
& See "Running a printer operation check" on page 106

If the check page prints correctly, make sure the printer driver and your application are 
installed correctly.

❏ If you are trying to print a large image, your computer may not have enough memory. 
Try reducing the resolution of your image or printing the image at a smaller size. You 
may need to install more memory in your computer.

❏ Users of Windows Me and 98 SE can clear any stalled print jobs from the spool 
manager.
& See "Canceling Printing" on page 47

❏ Uninstall the printer driver, then reinstall it.
& See "Uninstalling the Printer Software" on page 21

Print Head Carriage Problem

If the carriage cover does not close or the print head carriage does not move to its home 
position, open the carriage cover and push the ink cartridges down until they click into 
place.
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Increasing the Print Speed
Troubleshooting 12

Follow the instructions in this section to select settings that increase the print speed.

General tips

New :Depends on modelMatch with printer driver UIJust as printing at a high resolution requires more processing time than printing at a low 
resolution, printing in color takes longer than printing in black-and-white because the 
volume of data in a color document is much larger. For this reason, it is important to be 
selective in your use of color printing if you also require a fast print speed.

However, even if your document requires the highest resolution and extensive use of 
color—for example, when you are printing a camera-ready composite that includes color 
photographs—it may still be possible to optimize the print speed by adjusting other print 
settings and changing the operating environment. Keep in mind that some settings that 
increase the print speed may also lower print quality.

The following table lists the factors that affect print speed and print quality.

* Varies depending on the media type.

The table below lists the factors affecting print speed only.

Print quality
Print speed 

Lower
Faster 

Higher
Slower 

Printer settings Paper & Quality Options
(Windows),
Print Quality 
(Macintosh)* 

Fast Economy, 
Economy, 
Draft, Normal

Fine, Super Fine, 
Photo, Best 
Photo, Photo 
RPM

High Speed On Off

Image characteristics Image size Small Large

Resolution Low High
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Print speed Faster Slower

Printer settings Orientation Portrait Landscape
Troubleshooting 12

* Varies depending on the printer driver and application.

Selecting Speed & Progress settings (for Windows only)

You can increase print speed by selecting certain settings in the Speed & Progress 
window. Click the Speed & Progress button on your printer driver’s Maintenance window.

Black Ink Only On Off

Mirror Image* Off On

Edge smoothing* Off On

PhotoEnhance Off On

Collate* Off On

Reverse Order* Off On

Hardware resources System speed Faster Slower

Free hard disk space Large Small

Available memory Large Small

Software status Running applications One Many
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The following screen appears.
Troubleshooting 12

The table below lists the factors affecting print speed.

For more details on each item, see the online help.

Print speed Faster Slower

High Speed Copies On Off

Always spool RAW datatype (Windows XP and 2000) On Off

Page Rendering Mode (Windows XP and 2000) On Off

Print as Bitmap (Windows XP and 2000) On Off
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Appendix A 

Where To Get Help
Where To Get Help 12

New :See comments to select sections you need. The word "other" indicates products except for inkjet, SPC, Page, and SIDM.

Technical Support Web Site

New :Only inkjet, SPC, and Scanner products are used in this section.Epson's Technical Support Web Site provides help with problems that cannot be solved 
using the troubleshooting information in your product documentation. If you have a Web 
browser and can connect to the Internet, access the site at:

http://support.epson.net/

If you need the latest drivers, FAQ's, manuals, or other downloadables, access the site at:

http://www.epson.com

Then, select the support section of your local EPSON web site.

Contacting Customer Support

New :For All products

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the 
troubleshooting information in your product documentation, contact customer support 
services for assistance. If customer support for your area is not listed below, contact the 
dealer where you purchased your product.

Customer support will be able to help you much more quickly if you give them the following 
information:

❏ Product serial number
(The serial number label is usually on the back of the product.) 

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product software.)
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❏ Brand and model of your computer

❏ Your computer operating system name and version
Where To Get Help 12

❏ Names and versions of the software applications you normally use with your product

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact 
EPSON Customer support.

Help for Users in Australia

New :For all productsEpson Australia wishes to provide you with a high level of customer service. In addition to 
your product documentation, we provide the following sources for obtaining information:

Your Dealer

Don’t forget that your dealer can often help identify and resolve problems. The dealer 
should always be the first call for advise on problems; they can often solve problems 
quickly and easily as well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the 
occasional surf! The site provides a download area for drivers, Epson contact points, new 
product information and technical support (e-mail).

Epson Faxback Service

Epson Faxback service will fax you the latest specifications for most Epson products 
offered in Australia. Phone (02) 9903 9075 and the system will guide you through a number 
of choices before faxing the information to your fax machine.

Epson Helpdesk

Epson Helpdesk is provided as a final backup to make sure our clients have access to 
advise. Operators on the Helpdesk can aid you in installing, configuring and operating your 
Epson product. Our Pre-sales Helpdesk staff can provide literature on new Epson products 
and advise where the nearest dealer or service agent is located. Many types of queries are 
answered here.

The Helpdesk numbers are:
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Phone: 1300 361 054

Fax: (02) 8899 3789
Where To Get Help 12

We encourage you to have all the relevant information on hand when you ring. The more 
information you prepare, the faster we can help solve the problem. This information 
includes your Epson product documentation, type of computer, operating system, 
application programs, and any information you feel is required.

Help for Users in Singapore

New :For All productsSources of information, support, and services available from Epson Singapore are:

World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers for download, Frequently Asked Questions 
(FAQ), Sales Enquiries, and Technical Support via e-mail are available.

Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problem

❏ Enquiries on repair service and warranty

Help for Users in Thailand

New :For all productsContact for information, support, and services are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers for download, Frequently Asked Questions 
(FAQ), and e-mail are available.

Epson Hotline (Phone: (66) 2-670-0333)

Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information
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❏ Product usage questions or problem

❏ Enquiries on repair service and warranty
Where To Get Help 12

Help for Users in Vietnam

New :For all productsContacts for information, support, and services are:

Help for Users in Indonesia

New :For all productsContacts for information, support, and services are:

World Wide Web (http://www.epson.co.id)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline

❏ Sales enquiries and product information

❏ Technical support

Epson Service Center

Epson Hotline (Phone): 84-8-823-9239

Service Center: 80 Truong Dinh Street, District 1, Hochiminh City Vietnam

Phone (62) 21-572 4350

Fax (62) 21-572 4357

Jakarta Mangga Dua Mall 3rd floor No 3A/B
Jl. Arteri Mangga Dua,
Jakarta
Phone/Fax: (62) 21-62301104

Bandung Lippo Center 8th floor
Jl. Gatot Subroto No.2
Bandung
Phone/Fax: (62) 22-7303766
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Surabaya Hitech Mall lt IIB No. 12
Jl. Kusuma Bangsa 116-118
Surabaya
Where To Get Help 12

Help for Users in Hong Kong

New :For All productsTo obtain technical support as well as other after-sales services, users are welcome to 
contact Epson Hong Kong Limited.

Internet Home Page

Epson Hong Kong has established a local home page in both Chinese and English on the 
Internet to provide users with the following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of Epson product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:

Phone: (62) 31-5355035
Fax: (62) 31-5477837

Yogyakarta Hotel Natour Garuda
Jl. Malioboro No. 60
Yogyakarta
Phone: (62) 274-565478

Medan Wisma HSBC 4th floor
Jl. Diponegoro No. 11
Medan
Phone/Fax: (62) 61-4516173

Makassar MTC Karebosi Lt. Ill Kav. P7-8
JI. Ahmad Yani No.49
Makassar
Phone: (62) 411-350147/411-350148

Phone: (852) 2827-8911
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Fax: (852) 2827-4383
Where To Get Help 13

Help for Users in Malaysia

New :For All productsContacts for information, support, and services are:

World Wide Web (http://www.epson.com.my)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Trading (M) Sdn. Bhd.

Head Office.

Epson Helpdesk

❏ Sales enquiries and product information (Infoline)

❏ Enquiries on repair services & warranty, product usage and technical support 
(Techline)

Help for Users in India

New :For all productsContacts for information, support, and services are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers for download, and products enquiry are 
available.

Phone: 603-56288288

Fax: 603-56288388/399

Phone: 603-56288222

Phone: 603-56288333



1

CUSTO.FM (A4 size) Rev.CR4CJ35P User’s Guide

Epson India Head Office - Bangalore:
Where To Get Help 13

Epson India Regional Offices:

Toll Free Telephone Support

To learn more about Epson products or to avail service support, please call 1600 440011. 
This is a toll-free number and can be accessed (9 A.M to 9 P.M) anywhere in the country.

Help for Users in the Philippines

New :For All productsTo obtain technical support as well as other after sales services, users are welcome to 
contact the Epson Philippines Corporation at the telephone and fax numbers and e-mail 
address below:

World Wide Web (http://www.epson.com.ph) 

Phone: 30515000

Fax: 30515005/30515078

Mumbai Phone: 28261516-17
Fax: 28257287

Delhi Phone: 26447201/02/03/04/07/09
Fax: 26447205

Chennai Phone: 28203940/41 -- 28218658/59
Fax: 28272463

Kolkata Phone: 22831589/90
Fax: 22831591

Hyderabad Phone: 55331738/39
Fax: 55328633

Cochin Phone: 2357638/2356652
Fax: 2357950

Pune Phone: 24335460/90 Ext 214
Fax: 24330881

Ahmedabad Phone: 26407176/77
Fax: 26407347

Phone: (63) 2-813-6567

Fax: (63) 2-813-6545

E-mail: epchelpdesk@epc.epson.com.ph
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Information on product specifications, drivers for download, Frequently Asked Questions 
(FAQ), and E-mail Enquiries are available.
Where To Get Help 13

Epson Helpdesk (Phone: (63) 2-813-6567)

Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty
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Chapter B 

Product Information
Product Information 13

Ink and Paper

Ink cartridges

New :Depends on model (See Spec)You can use the following ink cartridges with this printer:

Note:
Ink cartridge part numbers vary by location.

Paper

New :Dependson model (See Spec)Epson offers specially-designed paper and other print media for all your printing needs.

Ink cartridge Part numbers

DX6000 Series CX5900 Series

Black T0711 T0731

Cyan T0712 T0732

Magenta T0713 T0733

Yellow T0714 T0734
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Paper Size Part numbers

Epson Premium Ink Jet Plain Paper A4 S041214
Product Information 13

* For updated information, check the Epson support site.

Epson Bright White Ink Jet Paper A4 S041442

S041749

Epson Premium Glossy Photo Paper A4 S041285

S041287

S041297

S041624

10 × 15 cm 
(4 × 6 in.)

S041692 

S041706 

S041729 

S041822

S041730 

S041750

S041826

13 × 18 cm 
(5 × 7 in.)

S041464

S041875

Epson Premium Semigloss Photo Paper A4 S041332

10 × 15 cm 
(4 × 6 in.)

S041765

S041925

S042054

Epson Ultra Glossy Photo Paper A4 S041927

13 × 18 cm 
(5 × 7 in.)

S041944

10 × 15 cm 
(4 × 6 in.)

S041926

S041943

Epson Matte Paper-Heavyweight A4 S041256

S041258 

S041259

Epson Glossy Photo Paper A4 *

10 × 15 cm 
(4 × 6 in.)

*

13 × 18 cm 
(5 × 7 in.)

*

Epson Photo Quality Ink Jet Paper A4 S041061

S041862
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Note:
The availability of paper varies by location. For the latest information on the paper available in your 
area, check the Epson support site.
Product Information 13

& See "Technical Support Web Site" on page 125

Exif Print and PRINT Image Matching

New :Only for model with this featureExif Version 2.2 (also called Exif Print, an international standard for digital cameras) and 
PRINT Image Matching allow you to print fine-quality photographs using a digital camera 
and printer that support these features.

Note:
We recommend using EPSON Easy Photo Print when printing photos using Exif Print or PRINT 
Image Matching.

Exif Print

When you take photographs using an Exif Print-compatible digital camera, information 
about camera settings and scene conditions is embedded in the photo file. This includes 
exposure mode, white balance, gain control, contrast, saturation, and sharpness.

Your printer corrects and enhances the photo using this information, then prints your image 
as it was captured by the digital camera.

PRINT Image Matching 

PRINT Image Matching gives control of the printing process to the digital camera, so your 
printed images can reflect the camera’s distinctive qualities. In a PRINT Image 
Matching-compatible digital camera, print command information from the camera is 
embedded in the photo file.

The print commands instruct your printer how to correct color and details based on this 
information, which includes gamma, color space, color balance, shadow point, contrast, 
and brightness settings. Your PRINT Image Matching-compatible printer then prints your 
image as it was captured by the digital camera.

Note:
❏ See your camera manual to determine if the camera is compatible with PRINT Image Matching, 

and for instructions on using the feature.

❏ EPSON Easy Photo Print lets you decide whether to print using PRINT Image Matching.

❏ If you print using software that does not support PRINT Image Matching, the benefits of PRINT 
Image Matching will not be visible in your prints.
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Compatible paper types
Product Information 13

Exif Print and PRINT Image Matching are compatible only when you are printing with these 
types of paper: 

System Requirements

For using the printer

New :Depends on model (See Spec)

Windows requirements

New :We unlocked this section for modification request.To use this printer, you must have Windows XP Home Edition, Millennium Edition, 98 
Second Edition, XP Professional x64 Edition, XP Professional, or 2000 Professional 
installed.For details on interfaces and operating systems, refer to the following table.

Plain Paper

Epson Premium Ink Jet Plain Paper

Epson Bright White Ink Jet Paper

Epson Glossy Photo Paper

Epson Photo Quality Ink Jet Paper

Epson Matte Paper-Heavyweight

Epson Premium Glossy Photo Paper

Epson Premium Semigloss Photo Paper

Epson Ultra Glossy Photo Paper

Interface System

USB 2.0 Windows XP Home Edition, XP Professional x64 Edition, XP 
Professional, and 2000 Professional

(Operating systems upgraded from Windows Millennium 
Edition, 98, and 95 are not supported by the software.) 

USB 2.0 Host Driver by Microsoft must be used. 

USB 1.1 Windows XP Home Edition, Millennium Edition, 98 Second 
Edition, XP Professional x64 Edition, XP Professional, and 
2000 Professional

(Operating systems upgraded from Windows 95 are not 
supported by the software.)

The USB interface must be used in full speed mode. 
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Macintosh requirements

New :We unlocked this section for modification request.
Product Information 13

To connect this printer to a Macintosh computer, you must use a USB cable.For details on 
interfaces and operating systems, refer to the following table.

For using the User’s Guide

New :Depends on model

Technical Specifications

Paper

New :Depends on model (See Spec)

Note:
❏ Since the quality of any particular brand or type of paper may be changed by the manufacturer 

at any time, Epson cannot attest to the quality of any non-Epson brand or type of paper. Always 
test samples of paper stock before purchasing large quantities or printing large jobs.

❏ Poor quality paper may reduce print quality and cause paper jams or other problems. If you 
encounter problems, switch to a higher grade of paper.

❏ Use paper under normal conditions:
Temperature 15 to 25 °C (59 to 77 °F) 
Humidity 40 to 60% RH 

Single sheets:

Interface System

USB 2.0/USB 1.1 PowerPC-based Macintosh computers running Mac OS X 
10.2.8 or later

Intel-based Macintosh computers with Rosetta

For Windows

Browser Microsoft Internet Explorer 4.0 or later (recommended)

For Macintosh

Browser Microsoft Internet Explorer 4.0 or later (recommended)
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Size A4 210 × 297 mm 

10 × 15 cm (4 × 6 in.) 
Product Information 13

Envelopes:

Printable area

New :Depends on modelDiagonal lines show printable area.

Single sheets and index cards: 

13 × 18 cm (5 × 7 in.) 

A6 105 × 148 mm 

A5 148 × 210 mm 

B5 182 × 257 mm 

9 × 13 cm (3.5 × 5 in.) 

13 × 20 cm (5 × 8 in.) 

20 × 25 cm (8 × 10 in.) 

Letter 8 1/2 × 11 in.

Legal 8 1/2 × 14 in.

16:9 wide size (102 × 181 mm)

Paper types Plain bond paper or special paper distributed by Epson

Thickness
 (for plain bond 
paper) 

0.08 to 0.13 mm (0.003 to 0.005 in.)

Weight 
(for plain bond 
paper) 

64 g/m2 (17 lb) to 90 g/m2 (24 lb)

Size Envelope #10 4 1/8 × 9 1/2 in.

Envelope DL 110 × 220 mm 

Envelope C6 114 × 162 mm 

Paper types Plain bond paper

Weight 75 g/m2 (20 lb) to 90 g/m2 (24 lb)

Normal Borderless
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A

Product Information 13

Envelopes:

Note:
Depending on the type of paper, print quality may decline in the top and bottom areas of the 
printout, or the area may be smeared.

A: The minimum top margin is 3.0 mm (0.12").

B-L: The minimum left margin is 3.0 mm (0.12").

The minimum left margin is 5.0 mm (0.20") for envelopes. 

B-R: The minimum right margin is 3.0 mm (0.12").

The minimum right margin is 5.0 mm (0.20") for envelopes. 

C: The minimum bottom margin is 3.0 mm (0.12") for single sheets.

D: The minimum bottom margin is 20 mm (0.78") for envelopes.

C

B-L B-R

A

B-RB-L

D
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Memory card slots
Product Information 14

*  Adapter required.

Memory card slot compatibility:

Compatible memory 
cards

CompactFlash 

Memory Stick

Memory Stick PRO

Memory Stick Duo*

Memory Stick PRO Duo*

MagicGate Memory Stick

MagicGate Memory Stick Duo*

Microdrive

SD Memory Card

SDHC Memory Card

MultiMediaCard

miniSD card*

miniSDHC card*

microSD card*

microSDHC card*

xD-Picture Card

xD Picture Card Type M

xD Picture Card Type H

Voltage Requirements 3.3 v

Maximum current is 500 mA

CF Type II card slot Compatible with CF+ and CompactFlash 
Specification 3.0 cards

Memory 
Stick/MemoryStick 
PRO card slot

Compatible with Memory Stick Standard version 
1.42-00 or Memory Stick Standard Memory Stick PRO 
Format Specifications version 1.02-00 cards

SD/MMC card slot Compatible with SD Memory Card Specifications / 
PART1. Physical Layer Specification Version 2.00 
cards and MultiMediaCard Standard Version 4.1 
cards

xD-Picture card slot Compatible with xD-Picture Cards. Card 
Specification Version 1.20 Type M and Type H cards.
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Ink cartridges
Product Information 14

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

c
Caution:
❏ Epson recommends the use of genuine Epson ink cartridges. Other products not 

manufactured by Epson may cause damage that is not covered by Epson’s warranties, 
and under certain circumstances, may cause erratic printer behavior.

❏ Do not use an ink cartridge if the date on the package has expired.

❏ Do not refill the ink cartridge. Other products not manufactured by Epson may cause 
damage that is not covered by Epson’s warranties, and under certain circumstances, may 
cause erratic printer behavior.

Mechanical

New :Depends on model (See Spec)

* Including the raised LCD section.

Color Yellow, Magenta, Cyan, Black

Cartridge life Within 6 months of opening the package at 25 °C (77 °F)

Temperature Storage:
-20 to 40 °C (-4 to 104 °F) 

1 month at 40 °C (104 °F)

Freezing:*
-16 °C (3.2 °F)

Paper path Sheet feeder, top entry

Sheet feeder 
capacity

About 100 sheets at 64 g/m2 (17 lb) paper

Dimensions Storage

Width: 463 mm (18.2 inches)

Depth: 354 mm (13.9 inches)

Height: 196 mm (7.7 inches)*

Printing

Width: 463mm (18.2 inches)

Depth: 491 mm (19.3 inches)

Height: 284 mm (11.2 inches)

Weight Approx. 6.9 kg (15.2 lb) without the ink cartridges
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Electrical

New :Depends on model (See Spec)
Product Information 14

Note:
Check the label on the back of the printer for its voltage.

Environmental

New :Depends on model (See Spec)

* Without condensation

Standards and approvals

New :Depends on model (See Spec)U.S. model: 

100-120 V Model 220-240 V Model

Input voltage range AC 90 to 132 V AC 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4 A (Max. 0.7 A) 0.2 A (Max. 0.4 A)

Power 
consumption

Copying Approx. 13 W 
(ISO/IEC10561 
Letter Pattern)

Approx. 13 W 
(ISO/IEC10561 
Letter Pattern)

Low power 
mode

Approx. 5.0 W Approx. 5.0 W

Sleep mode Approx. 3.5 W Approx. 3.5 W

Power off 
mode

Approx. 0.2 W Approx. 0.3 W

Temperature Operation:
10 to 35 °C (50 to 95 °F)

Storage: 
-20 to 40 °C (-4 to 104 °F)

1 month at 40 °C (104 °F)

Humidity Operation:* 
20 to 80% RH

Storage:* 5 to 85% RH

Safety UL 60950-1
CSA C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B 
CAN/CSA-CEI/IEC CISPR 22 Class B
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European model: 
Product Information 14

Australian model:

Interface

New :Depends on model (See Spec)

Low voltage directive 73/72/EEC EN 60950-1

EMC directive 89/336/EEC EN55022 Class B 
EN61000-3-2 
EN61000-3-3
EN55024

EMC AS/NZS CISPR22 Class B

USB 2.0 Hi-Speed (Device Class for computers)

USB 2.0 Hi-Speed (Mass Storage Class for external storage devices)
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Safety Instructions
Safety Instructions 14

Important Safety Instructions

New :Depends on modelRead all of the instructions in this section before using the printer. Also, be sure to follow 
all warnings and instructions marked on the printer.

Setting up the printer

Observe the following when setting up the printer:

❏ Do not block or cover the vents and openings in the printer.

❏ Use only the type of power source indicated on the printer’s label.

❏ Use only the power cord that comes with the printer. Use of another cord may result in 
fire or electric shock.

❏ The printer’s power cord is for use with the printer only. Use with other equipment may 
result in fire or electric shock.

❏ Be sure your AC power cord meets the relevant local safety standard.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that 
regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or the base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that the total ampere rating of 
the devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure that the total ampere rating of all devices plugged into the wall outlet 
does not exceed the wall outlet’s ampere rating.

❏ Do not attempt to service the printer yourself.

❏ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:
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The power cord or plug is damaged; liquid has entered the printer; the printer has been 
dropped or the casing damaged; the printer does not operate normally or exhibits a 
distinct change in performance.
Safety Instructions 14

❏ If you plan to use the printer in Germany, the building installation must be protected by 
a 10 or 16 amp circuit breaker to provide adequate short-circuit protection and 
over-current protection for the printer.

❏ When connecting the printer to a computer or other device with a cable, ensure the 
correct orientation of the connectors. Each connector has only one correct orientation. 
Inserting a connector in the wrong orientation may damage both devices connected by 
the cable.

Choosing a place for the printer

Observe the following when choosing a place for the printer:

❏ Place the printer on a flat, stable surface that extends beyond the base of the printer in 
all directions. If you place the printer by the wall, leave more than 10 cm between the 
back of the printer and the wall. The printer will not operate properly if it is tilted at an 
angle.

❏ When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside 
down. Otherwise, ink may leak from the cartridges.

❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the 
printer away from direct sunlight, strong light, or heat sources.

❏ Avoid places subject to dust, shocks, or vibrations.

❏ Leave enough room around the printer to allow for sufficient ventilation.

❏ Place the printer near a wall outlet where the plug can be easily unplugged.

Using the printer

Observe the following when using the printer:

❏ Do not insert objects through the slots in the printer.

❏ Take care not to spill liquid on the printer.

❏ Do not put your hand inside the printer or touch the ink cartridges during printing.
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❏ Do not use aerosol products that contain flammable gases inside or around this 
product. Doing so may cause fire.
Safety Instructions 14

❏ Do not move the print head by hand; otherwise, you may damage the printer.

❏ Always turn the printer off using the P On button. When this button is pressed, the 
P On light flashes. Do not unplug the printer or turn off the power to the outlet until the 
P On light stops flashing.

❏ Before transporting the printer, make sure that the print head is in the home (far right) 
position and the ink cartridges are in place.

❏ Leave the ink cartridges installed. Removing the cartridges can dehydrate the print 
head and may prevent the printer from printing.

❏ Be careful not to trap your fingers when closing the scanner unit.

Handling ink cartridges

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink from or 
handle the cartridges.

❏ Shake new ink cartridges four or five times before opening their packages.

❏ Do not shake ink cartridges after opening their packages; this can cause leakage.

❏ Be careful when you handle used ink cartridges, as there may be some ink remaining 
around the ink supply port. If ink gets on your skin, wash the area thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately with water. If discomfort or 
vision problems remain after a thorough flushing, see a doctor immediately.

❏ Do not remove or tear the label on the cartridge; this can cause leakage.

❏ Install the ink cartridge immediately after you remove it from its package. If you leave a 
cartridge unpacked for a long time before using it, normal printing may not be possible.

❏ Do not use an ink cartridge beyond the date printed on the cartridge carton: otherwise, 
it may result in reduced print quality. For best results, use up the ink cartridges within 
six months of first installing them.

❏ Do not dismantle ink cartridges or try to refill them. This could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.
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❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the side of the cartridge. Doing so may prevent 
Safety Instructions 14

normal operation and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge related-information such 
as the ink cartridge status, so that the cartridge may be removed and reinserted freely. 
However, each time the cartridge is inserted, some ink is consumed because the printer 
automatically performs a reliability check.

❏ If you remove an ink cartridge for later use, protect the ink supply area from dirt and 
dust, and store it in the same environment as the printer. A valve in the ink supply port 
makes covers or plugs unnecessary, but the ink may stain items that come into contact 
with this area of the cartridge. Do not touch the ink supply port or the surrounding area.

❏ Store ink cartridges with their labels facing upward. Do not store cartridges upside 
down.

Using memory cards

New :only for model with this feature

❏ Do not remove a memory card or turn off the printer while the memory card light is 
flashing.

❏ The methods for using memory cards vary according to card type. Be sure to refer to 
the documentation packaged with your memory card for details.

❏ Use only memory cards compatible with the printer.
& See "Supported memory cards" on page 90

Using the LCD screen

New :only for model with this feature

❏ The LCD screen may contain a few small bright or dark spots. These are normal and do 
not mean that they are damaged in any way.

❏ Only use a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical 
cleansers.

❏ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on 
your hands, wash them thoroughly with soap and water. If the liquid crystal solution 
gets into your eyes, flush them immediately with water. If discomfort or vision problems 
remain after a thorough flushing, see a doctor immediately.
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ENERGY STAR® Compliance

New :Unlock to replace the image data.
Safety Instructions 14

Warnings, Cautions, and Notes

Warnings, Cautions, and Notes in this User's Guide are indicated as below and have the 
following meaning.

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of the printer.
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